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Important Notice  
 
Welcome to Autodesk.         
This document is supplied as part of an Autodesk Training Course. It is not intended to be distance-learning material: rather as an aid for Tutors when presenting material to course delegates and as a subsequent aid memoir to those delegates.    
Autodesk does not accept responsibility for any personal belongings / valuables whilst on the premises. Delegates are advised to keep their belongings with them at all times.    
Autodesk has no control over the use of the software described in this document and cannot accept any responsibility for any loss or damage caused as a result of using the software. Users are advised that all results from the software are checked by a competent person in accordance with good quality control procedures.    
The software described in this document is furnished under a license agreement and may be used only in accordance with the terms of this license.    
Copyright 2016 – Autodesk.  
All rights reserved. 
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1.  Introduction 
 
 
PowerInspect is a CAD based inspection solution package for use with many types of inspection hardware, including manual and CNC CMMs, portable arms, optical measuring devices and CNC machine tools (OMV). 
PowerInspect allows you to rapidly create a complete inspection, and automatically generate a high quality report using either HTML format or Microsoft Excel. The inspection reports can be customised to include pictorial, tabulated and statistical data, meeting the demands of design requirements and agreed international standards. 
You are given instant results during the inspection, and the onscreen reaction and detailed graphical displays give immediate feedback for each measured point. 
PowerInspect supports models from neutral formats such as IGES. If the relevant Exchange translators are purchased, PowerInspect can import data created by third party software packages, such as CATIA, Unigraphics, SolidWorks and IDEAS. 
The user interface is intuitive and easy to use, and the learning curve is short, allowing the operator to get the most from the measuring device in the shortest possible time. 
The examples given in these training notes are specific to the demo block model used in the training course. The techniques should be learnt and adapted to your own requirements. 
 
PowerInspect gives you: 
 Comparison against all mainstream CAD formats. 
 Rapid alignment, even for complex free form shapes. 
 Simple and rapid measurements between features. 
 The ability to inspect user-defined sections. 
 The ability to inspect along the edge of a part. 
 Full geometric inspection capabilities. 
 Automatic creation of inspection features from CAD nominals. 
 The ability to apply geometric dimensioning and tolerance (GD&T). 
 Point, wireframe and surface export for measured entities.  
 CAD manipulation, including surface offsetting (for example, the reverse side for sheet metal, or a spark gap for electrodes). 
 Measurement without CAD data.   
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1.1 Opening PowerInspect 
To open PowerInspect, double-click the desktop icon . 
The screen should look as follows: 

 
 
The work environment remains empty until you start a new session. When a new session is started, further options become available in the Menu bar, and a graphics window, Sequence Tree and context-sensitive toolbar are generated. 
 
1.2 Creating a new session 
A new session can be started from the File menu or from the Main toolbar. 

 New Session  creates a new inspection document without loading a CAD model. 

 New Session Wizard  allows you to choose whether you want to open one or more CAD models. When you start a new session using the New Session Wizard, you are guided through the process step by step. 
 If a PowerInspect session (*.pwi) already exists, you can select File > Open from the 

Main menu. Alternatively, click Open  on the Main toolbar.  
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New Session Wizard 
1 Click the New Session Wizard  button to open the New Inspection Session dialog. 

 
This dialog contains three options for creating an inspection session: 
 Measurement without CAD creates an inspection session without opening a CAD model. 

This is the same as selecting New Session  from the Main toolbar. 
 Measurement with a single CAD Part creates an inspection session using one CAD model. 
 Measurement with multiple CAD Parts creates an inspection session using multiple CAD models.  

2 Select Measurement with a single CAD part and click Next to display the second page of the 
wizard. 

 
Use this dialog to browse to the CAD file that you want to open. You can also specify the Units you want to work in, and specify offsets for surface and edge points. 

3 Click New to browse to the CAD file for the part you want to inspect.  
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4 In the Open dialog, select DemoBlock2008(CMM+Arm).dgk and click Open. 
 After a CAD file has been selected, it can be transformed. Click Details to display the CAD Details dialog and select Transformation Matrix (for further details, see Chapter 2). 

5 Click Next to display the next page of the wizard, Variables. 
The Variables dialog allows you to choose the template in which you want to report your measurements. Click Browse to navigate to the template file you want to use. 

 
PowerInspect has the ability to create reports in two formats: 
 HTML format reports are created directly inside the PowerInspect *.pwi file, and are accessible through the Report tab below the graphics window. 
 Microsoft Excel reports allow backwards compatibility for older versions. 
 Entries can be edited by clicking on the required field and editing the contents. 

6 Click Finish to complete the process and begin the session.  
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The Graphics Window 
 
When a session is open, a number menus and toolbars are displayed, as shown below. 
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The Graphics window includes the following tabs: 
 CAD View displays the CAD model and all inspected results.  
 Info displays information about a selected Sequence Tree item. 
 Report displays the report in HTML format. 
 Dynamic Points lists the points used to create a free form alignment or guided 

inspection. 
 Section displays the section each time you create a Section group. This tab is only available if you have created Section group. 
 Point Cloud displays the points in the selected point cloud, together with a graph and selected statistics. 
 Digitised Points displays the points in the selected Digitised Curve item.  
Menu bar 
The Menu bar is located at the top of the main window. 

 
Click on a menu item to open it. If a menu item is unavailable, it does not apply to the 
currently active document. A small arrow  next to a menu item indicates that there are more options available. Move the cursor over the menu item to display these options. 

 
Click outside a menu to cancel any command. 
Main toolbar 
The Main toolbar is displayed at the top of the graphics window under the Menu bar. The 
buttons allow easy access to the most frequently used PowerInspect menu items. 
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Item toolbar 
The Item toolbar is used for the creation of alignments, geometric groups, inspection 
groups, and datums. 

 
The toolbar changes according to the function chosen. 
Click on an icon with a small arrow next to it to open that item's submenu. For example, 
clicking the Miscellaneous  button displays the following toolbar: 

 
CAD View toolbar 
The CAD View toolbar contains options to orientate and shade the CAD model.  

 
View Options toolbar 
The View Options toolbar enables you to display measurement data in the graphics 
window, and to control the information that is displayed. 

 
Mouse Context toolbar 
The Mouse Context toolbar enables you to choose the function of the cursor. 

 
Toolbar visibility 
Right-click in and empty area of the toolbar or menu bar to toggle the visibility of all toolbars. 
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Tools > Options 
Select Tools > Options from the Menu bar to specify settings for various PowerInspect features. 
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Views and View Manipulation 
After the new session has been created, you can view the CAD model in order to gain some visual information about the part. To do this, the various views and their manipulation need to be understood. 
Before running through the views and view manipulation, the use of the mouse functions will be established. 
Mouse buttons 
 
Each of the three mouse buttons performs a different dynamic operation. 
 
 Left mouse button: Picking and selecting 

 This button is used for selecting items from the menus, options within dialogs, and items 
in the graphics area. 
It is also responsible for view manipulation depending on the setting used in the Set 

Mouse Button 1 View Mode  button. 
 
 Middle mouse button: Dynamics 

 
 Zooming in and out: Hold down the Ctrl key and the middle mouse button. Move the mouse up and down to zoom in and out. Alternatively, rotate the scroll wheel, if available. 
 Pan around the model: Hold down the Shift key and the middle mouse button. Move the mouse in the required direction. 
 Zoom box: Hold down the Ctrl and Shift keys, and drag a box around the area that 

you want to zoom into using the middle mouse button. 
 Rotate mode: Hold down the middle mouse button and move the mouse to rotate the view. 
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 Right mouse button: Dynamics, Special Menus & PowerInspect Sequence Tree Options 

 
 Zooming in and out: Hold down the Ctrl key and the right mouse button. Move the 

mouse up and down to zoom in and out. 
 Pan around the model: Hold down the Shift key and the right mouse button. Move the 

mouse in the required direction. 
 Zoom Box: Hold down the Alt key and the right mouse button. Drag a box around the area that you want to zoom into. 
 Rotate mode: Hold down the Ctrl and Shift keys, and use the right mouse button to rotate the view. 
 
When the right mouse button is pressed on its own, a popup menu is displayed based on the item that the mouse is over, such as the Sequence Tree, or the toolbar menus.  
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Graphics Area 
 This is the large, visual display area to the right of the Sequence Tree where the model 
is displayed. 
In the top right corner of the Graphics area is the ViewCube as shown below. 
 

 This is used to quickly select a range of standard viewing orientations. 
For an ISO1 view click the lower left corner of the ViewCube. 
 

  
To return to the default Top view select the Home symbol to the top left of the ViewCube. 
 

  
Another method would have been to select the central top area. 
 

 To enable 90 incremental rotation on the planer views select one of the circular arrows. 
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View menu 
The View menu is accessed from the Menu bar and contains the Resize to Fit option, and a number of View submenus. Each of these submenus corresponds to a different group 
of views. 
 

 
 
 From — these options allow you to alter the viewing angle of the part shown in the CAD view. 
 ISO — these options allow you to alter the CAD view layout. 
 Custom View — these options allow you to save the current CAD view for future use and to reload previously saved views. 
 Rotation Anchor — these options allow you to specify how the model in the CAD view is rotated. 
 Probe Paths — these options are only applicable for the CNC version of the software. 

They allow you to control which probe paths can be seen in the CAD view. 
 Grid Mode — these options allow you to specify the coordinate system in which the grid is displayed. 
 Level — These options allow you to group surfaces into levels and to control which levels are displayed in the CAD view 
 The View flyout shares these functions. 

  



  1.  Introduction 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            13                                                                                                                             

View flyout 
Open the View flyout by clicking the arrow below the Select View  button on the CAD 
View toolbar. This flyout contains a series of buttons that correspond to the same icons in the view menu. 

 
The 1, 2, 3, and 4 buttons are used to select the Custom Views, which can be saved using 
the corresponding Save  icon. Rotations can also be triggered using the Arrow keys on the keyboard, by dynamically moving the cursor using the Mouse Functions, or by 
using the Rotations  flyout. The rotation axis is selected from the flyout and the view then rotated incrementally by clicking on the icon.  
 
Window menu 
If more than one session is open, you can view all sessions in a single screen, using the 
Window menu. The sessions can then be arranged according to your preference. 
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The CAD View 
The CAD View is where all the inspection and geometric information is viewed. CAD models can be seen either with no shading, transparent shading, or solid shading, combined with or without wireframe. 

Click the Shading Mode For Model  button to open the Shading Mode 
 flyout and choose the shading you want to apply to the CAD model. Alternatively, use the shortcut keys to toggle the wireframe and shading.  

 w — toggle wireframe on/off 
 s — toggle shading on/off 

 
Solid Shading 

 
Transparent Shading 

 
Wireframe Shading 
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Surface normal direction 
PowerInspect has a function which allows you to determine the surface normal direction. 

Using the Highlight back-facing surfaces  button in combination with the shading, will show all reversed surfaces as bright red. This is useful for determining the direction needed for surface offsets. 
To reverse a surface: 

1 Click Highlight back-facing surfaces .  

2 Click Surface Selector . 
3 Click a surface to select it. The selected surface is highlighted yellow. 

 
4 Right-click in the graphics window and select Inverse Surface from the popup menu. 

 

 

 The selected surface changes colour to red to demonstrate that it has been reversed. 
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The Report Template 
PowerInspect allows you to select the report template you want to output your data to. If using the HTML format, the report is integrated into the PowerInspect work environment, and can be accessed at any time using the Report tab. These reports can 
be customised to suit the customer’s needs. 
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The Information Tab 
The Info tab allows you to view specific items for positional data, tolerances, deviations 
and errors. This can be displayed by selecting the item to be investigated from the Sequence Tree, and then selecting the Info tab. The following is then seen: 
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PowerInspect Help 
PowerInspect comes with an online help which can be accessed from the Help menu. When faced with a problem, it is best practice to make the Help menu your first port of 
call. 
To access the online help, select Contents from the Help menu. 

 
The most effective way to use the Reference Help is to use the Search tab to search for help topics, but you can also browse the Contents or Index.  

 
To target your search more effectively, enclose search terms within quotation marks. For example, to search for help on exporting point clouds, enter "Export point cloud" in the search box so that only topics containing this exact phrase are displayed. 
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Customising PowerInspect 
Select Tools > Options to display the Options dialog and specify settings and defaults for 
PowerInspect. 

 
Use the Options dialog to specify settings including, the colour of entities, the size of points, confetti or edge points and toggle displayed items such as the CAD Datum. 

 



               1. Introduction         
 

                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

20                                                                                                                                                                      Copyright © Autodesk                                                                                                                     

Device Connection 
The first time you open PowerInspect, the CMMDriver Configuration dialog is displayed. Before loading up, an active connection needs to be made to an inspection device. 
The CMMDriver Configuration dialog can also be opened manually from the Main menu. 

1 From the Main menu, select Tools > Machine Connection > Configure. The 
CMMDriverConfiguration dialog is displayed. 

 
2 Click Select to display the Select Connection Protocol dialog, which contains a list of 

connection protocols. 

 
3 Select the required protocol for the system that PowerInspect is to connected to and click 

OK. 
The correct connection protocol should now be set up. 

 Do not alter the connection protocol unless you are an experienced user. The original installation should have a connection already set up for your machine. 
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Starting Set-up 
Click the Toggle the Machine toolbar  button on the Main toolbar to display the 
Machine toolbar. 

 
Use this toolbar to: 

 Connect to  the machine. 

 Home  the machine. 

 Open the Tracking Box . 

 Change Probe Tool . 
 View the connection status of the CMM. 
 Making a Connection 
 To connect a CMM to PowerInspect: 

1 Click the Toggle the Machine toolbar  button on the Main toolbar to display the 
Machine toolbar. 

2 Click the Connection  button. Alternatively, select Tools > Machine Connection > 
Connection from the Main menu. 
If the connection is successful the status changes to Machine OK. 

 For a manual CMM, you are prompted to move the probe head to A = 0, B = 0. 
You may also be prompted to move the CMM to the home position. In most cases, this means moving all axes to 
their positive end stops, although machines can vary. 

3 If prompted, Home the CMM by clicking the Home  button. 
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There are a number of conditions displayed in the Status bar on the Machine toolbar: 
 When no session is open, the Status bar shows the status of the connection between PowerInspect and the measuring device: 
  PowerInspect is not connected to the machine. 
  PowerInspect is connected to the machine. 
 When one or more sessions are open, the Status bar shows the status of the connection between the active session and the measuring device: 
  Neither PowerInspect, nor the active session is connected to the machine. 
  PowerInspect is connected to the machine, but the active session  is not connected. 
  PowerInspect and the active session are connected to the machine. 
 The Status bar can also display the following information messages: 
  The machine is not homed. 
  The homing procedure has just completed successfully.  

 
 The connection procedure varies according to the measuring device. You should follow the prompts given on your own machine. When connected, the probes can be changed and edited.   
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2. CAD Management 
The manipulation of CAD data within PowerInspect is very important. Using the CAD File Manager, you can add or remove CAD files, transform CAD data in relation to datums and indicate levels to be included in the inspection. 
 
Coordinate Systems 
When you create an inspection session, PowerInspect automatically creates two coordinate systems:  
The Machine Datum is the X 0, Y 0, and Z 0 of the 3D coordinate measurement machine. 
The PCS Datum (Part Coordinate System Datum), is the X 0, Y 0, and Z 0 of the CAD model. If the PCS Datum is in the wrong location, you can transform it using translations and rotations. 
When the part is aligned with the CAD model, PowerInspect automatically converts the CMM movements from the Machine Datum coordinate system to the PCS Datum coordinate system. 
By default, these datums are not displayed in the CAD view. To display them, click the 
light bulb  icon next to their entries in the Sequence Tree. The icon changes to  to indicate the datums are displayed. In this example, the PCS Datum is shown at the corner of the part; the Machine Datum is shown above and left of the PCS Datum. 
 

  
In addition to the datums, a graphical representation of the coordinate system of the active alignment (the PCS Datum, by default) is displayed at bottom left of the CAD view. It allows you to identify the axes of the active alignment when the active alignment is not visible on screen. 
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CAD File Manager 
To display the CAD File Manager, select the CAD tab. 

 
When you select the tab, the window displays the Parts folder and the User Levels area. 
Click the  icon to open folder and display the sub-items. 
The following example shows the open Demo Block. It contains one part, with three levels. 

 
The coloured box indicates the colour with which each level is displayed in the CAD View. Change the colour by left-clicking the box, and assigning a new colour from the palette. 
The light bulbs indicate whether the level is displayed or not  in the CAD View, and 
the check box  includes or excludes the level from the CAD Context. These can all be switched on or off by left-clicking on them. 
When the CAD File Manager is opened, a toolbar is displayed at the top of the tab with a number of functions that can be used to manipulate the CAD data. 
 

  
This toolbar enables you to: 
 add or remove CAD files. 
 reset the user levels. 
 edit the CAD details. 
 show or hide CAD files and the detailed view. 
 highlight CAD details. 
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Click the CAD Details  button to open the CAD Details dialog. This dialog enables you to locate CAD files and perform transformations on them. 
Transformations are used to orientate parts within the CAD View. 
To transform any CAD data, you must first specify the part by using the Browse... button in the CAD Details dialog. 

 

 PowerInspect cannot change the CAD model. It can create, hide and edit levels but these cannot be saved to the CAD model and are only visible within PowerInspect. 
When the part is specified, click Transformation Matrix... to open the Transformation Matrix dialog. 

 
Use this dialog to specify any transformation (Rotation, Translation, Mirror and Scale), by clicking on the appropriate button and entering the desired values. 
For example, clicking Rotation opens the Rotation dialog. In this dialog, you can specify the rotational axis (for example, the X axis) and the angle by which the part is rotated (for example, 90 degrees). 

 



               2.  CAD Management         
 

                                                                                                                                      
                                                                                                             

 Autodesk PowerInspect 2017   
4                                                                                                                                                                      Copyright © Autodesk                                                                                                         

Click OK to close the Rotation dialog. The Transformation Matrix dialog is updated with the new value. 

 
Click Load to read and load workplanes from multiple CAD formats. 
 
When a CAD model is selected, the Select Workplane dialog lists all the workplanes associated to the model. 

 
When you select a workplane, its transformations are displayed in the Transformation Matrix dialog. 

 
Click OK to apply the transformations to the model relative to the datum. 
These transformations can be saved, deleted, edited and tested all within this same dialog. To edit or delete a transformation, left-click its entry in the central area of the Transformation Matrix dialog. 
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Summary and Detailed CAD View 
Click the Summary/Detailed View  button on the CAD File Manager toolbar to expand the CAD information area and display more information about the part files. 

 
The information displayed includes any transformations, the levels, part locations and the number of entities that make up the part. 
The extent values indicate the dimensions of the part in relation to the datum origin. 
Click Summary/Detailed View  again to return to the data summary. 

 
When the Levels section is expanded, the sub-levels reveal the individual surfaces.  
As before, the light bulbs hide  or show  the individual level or surface. The check 
box  includes or excludes the level from the CAD context. These icons can be switched ON or OFF by left clicking on them. 
The levels can also be managed from the Menu bar. 
Select Measures > CAD Levels for Inspection from the Menu bar to display the levels section as shown above. 
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CAD Menu Options 
As well as the CAD File Manager, CAD edits can be made using some of the options on the Menu bar. 
The Measures menu contains two options that are relevant to the CAD management.  

 
Select Parameters to open the Measure Parameters dialog. This dialog contains a series of tabs that relate to different areas of PowerInspect. 
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Select CAD Level for Inspection to open the CAD Object Selection dialog. This dialog allows you to select the levels and surfaces you want to make available for inspection. 
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Level Edits 
CAD data within PowerInspect can be transferred to other or new levels. 

Click the Surface Selector  button in the Mouse Context toolbar to specify which surfaces you want to move, and to which level. 
To create a new level: 

1 Click the Surface Selector  button on the Mouse Context toolbar. 
2 Use the left mouse button to box-select the surfaces that you want to add to a level. 

  

 When you release the mouse button, the selected surfaces are highlighted. Alternatively, you can select individual surfaces by left-clicking the model. 
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3 Right-click anywhere on the highlighted selection and select Group Surfaces from the local menu. 

 

  
The Level Manager dialog is displayed. 
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4 To add the selected surfaces to an existing level, select the level in the Available levels list, and select OK. 
To add the selected surfaces to a new level, enter a Name for the level, and click OK. The level appears in the 
User levels area of the CAD File Manager. 
 

 
 

This technique can be useful if there is a large quantity of data in a view. Each layer has an associated colour, which is used when colour shading the model. To change the shading colour of a level, left-click the small coloured box to the left of the level’s name, and select a new colour from the palette. 
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3. Alignments 
Alignment of the part or component allows PowerInspect to match the relative positions and orientations of the CAD and/or Machine datum. An alignment is normally the first item or task in the inspection sequence. The type of alignment strategy selected is dictated by the component's shape and which features, if any, can be used.  

Alignments are accessed by selecting the Alignment  flyout from the Item toolbar. 
 

  
The most widely used alignment strategies are outlined in this chapter. 
 
Geometric PLP Alignment  
A Geometric PLP Alignment  is an alignment based upon the relationship of a physical 
Plane, Line and Point (PLP), and CAD Defined Coordinates, which define the part in the X, 
Y and Z. It is considered to be a more accurate method of alignment (compared to the 
Free Form Alignment – see later) because it works directly from CAD Nominal Values, and can be an easier method to understand. 
Generating a Geometric PLP Alignment 
For this example the DemoBlock2008 CAD file is going to be used. 

1 Click New Document Wizard  to open the New Inspection Session dialog. 
2 Select Measurement with a single CAD Part and click Next. 
3 Click New and browse to DemoBlock2008(CMM+Arm).dgk. 
4 Leave the Offset and Tolerance settings unchanged, and click Next. 
5 In the Variables dialog, browse for any HTML Report Template (Excel could be used, but for this example HTML is to be used). 
6 Click Finish. 

 
The new session is now ready for inspection.  
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Choosing the Geometric features 
Before the alignment can begin, a decision needs to be made on where the Plane, Line and Point are going to be aligned to, and what will determine these elements. 
The Plane 
With any alignment, the results are better if a greater area spread is used to define the aligning elements. In this example, the CMM bed (or table) will be used to define the plane, because the model has a flat base, and all the planes in the model are small. 
The Line 
Lines can be defined from square edges (probed lines), or from the connection or intersection of measured features. In this example, the line is to be defined in the X-direction, using the centres of two measured circles on the part.  

 The line direction in a Geometric PLP Alignment must be axial. 
The Point 
Because the circles will have already been defined, the centre position of one of these circles will be used for the point position. 

 
The two circles chosen are indicated, and the plane will be the base area. The line will be between the centres of both circles, and the point will be taken from the centre of circle 1. 
Both circles and line will be projected onto the base (plane). 
Defining the Geometric Items 
When you have chosen the features to use for the alignment, you must now define the geometric items to probe. 

1 Click the Delay Measure  button on the Main toolbar. Alternatively, select Measures 
> Delay Inspection. 

 Delay Measure allows you to defer the measurement until all the items are specified. Otherwise, PowerInspect will automatically move to the probing process. 

2 Select Wireframe Checker , right-click an empty area of the graphics window and select Wireframe from the popup menu. 
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3 Move the cursor over the first circle, as shown below. The circumference is displayed in yellow to indicate it can be selected. Click to select it. 

 
4 In the Geometry Explorer tab, select New Probed Plane from the drop-down list and 

click . 
 

  
PowerInspect creates a geometric group and adds the new probed plane and the probed 
circle items to the inspection sequence. 
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5 Use the cursor to select the second circle, as shown below.  

t 

6 In the Geometry explorer, select Plane 1 from the Linked to drop-down list and click  to add a second circle to the Inspection sequence. 

7 Click the Lines  button to display the Lines flyout menu. 

8 Click  to display the Line: Two Points dialog. Ensure that the reference points are 
set as follows: 
 Reference Point 1 — Circle 1::Centre 
 Reference Point 2 — Circle 2::Centre 

 
9 Click OK to add the line item to the inspection sequence.  
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Probing the Geometric Items 
 
When the geometric items have been created, and the part is secured to the CMM bed, the probing process can begin. 
 

1 Click Play All  on the Main toolbar.  
Alternatively, right-click any item in the Inspection sequence to display the popup menu, 
and select the Play All option. 

 

 Selecting the Play Item  option plays only the selected item. Selecting Play All plays all unmeasured items. 
 

2 PowerInspect changes to Full Screen Measure Mode and displays the Feature Probing dialog, which prompts you to start probing the indicated item. 
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Full Screen Options Toolbar 
 
In Full Screen Measure Mode, a new toolbar is displayed at the right of the screen. This is called the Full Screen Options toolbar and contains the functions that are common to all measurement modes. 
 

 
 
 

 Toggle CAD Context Display selects the CAD levels that can be probed.  
 

 Edit CAD Levels Used For Inspection allows you to choose the levels used. 
 

 Toggle Previous Measure Display switches on/off all previously measured items in the view.  
 

 Change Probe opens the Probe Database Editor, allowing you to change probes and 
positions. 
 

 Tracking Box opens the Tracking Box, which displays the probe position in terms of 
CMM or CAD coordinates.  
 

 Help opens the reference help.  
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Feature Probing Dialogs 
 
When in full screen measure mode, the Feature Probing dialog is displayed, which contains options that you can use any stage during the probing process. The options available depend on the items being probed. For geometric items, the following options are available: 
 

 Reset All resets all the points taken for the currently active item.  
 

 Remove Last allows you to delete the details of the last probed point so that it can 
be probed again. This is useful when a mistake has been made and the point needs to be re-probed. 
 

 OK allows you to save your points when you have finished probing and are satisfied the points are accurate.  
 

 Cancel exits the probing mode without saving any of the probed points for the currently active item (items that have been successfully probed and accepted remain measured). 
 

 Tracking displays the point about to be probed in a view perpendicular to the point's 
normal. 
 

 When selected, Auto -Calculate calculates the feature while probing. When deselected, the feature is calculated when accepted. 
 

 When selected, Auto-Accept automatically saves items as soon as you have probed the required number of points. When deselected, you must save your measurements using the OK button. 
 

 When selected, Automatically extract nominals from CAD loads the nominal 
data and enables comparison with the CAD during probing. You must have previously 
measured the active alignment to use this option.  
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Feature Probing 
 
After you have clicked Play All, the first Feature Probing dialog is displayed and asks you 
to take a minimum number of points to define that feature. In this instance PowerInspect is asking you to probe three points to measure the plane. 
 

  
1 Probe three points around the part, using the CMM bed as the planar surface. As you probe each point, the counter at the top-right of the dialog displays the number 

of points taken. When you have probed the minimum number of points, the background 
colour changes from red to green. 



 3.  Alignments 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            9                                                                                                                             

  

2 When you have probed at least three points, click  to save them. 
 

 If Auto-Accept  is enabled, PowerInspect automatically saves your measurements when you have probed the minimum number of points. 
 PowerInspect plays the next item in the inspection sequence. The next Feature Probing 
dialog is displayed asking you to take a minimum number of points to measure Circle 1. 
   



               3. Alignments         
 

                                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

10                                                                                                                                                                      Copyright © Autodesk                                                                                                                                                      

  
However, rather than the minimum three points, four points will be taken for the circles, 
at the North, East, South and West positions. This makes it easier for you to probe an 
even spread of points. 

3 Probe four points inside Circle 1, which is highlighted on CAD model on screen.  
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4 When the points have been probed select  to save them. 
5 Repeat the process for Circle 2. 

When all the items have been probed, the Inspection sequence is updated, and all the items lose their crosses. 

 
The line was not probed but its red cross icon has gone because the centres of the two circles determine the line’s position. These have been probed, and therefore satisfy the measurement conditions. 
 

 The point required for the alignment will be specified as the centre of Circle 1. 
 
Click on the Expand  icon next to each item to show basic information about it. 
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The unaligned items can be seen in the CAD View with purple wireframe and blue shading. For example:  

 

 If the probed items cannot be seen, press the Resize to Fit  button to resize the screen to fit the model, because the items may lie some distance away from the model at this point. 
 
You must now create an alignment to align the probed positions with the CAD model.   
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Generating the Geometric PLP Alignment 
To create the Geometric PLP Alignment, some CAD nominals need to be known. These nominals create the relationship between the probed positions and the CAD model, and orientate them in terms of the X, Y and Z coordinates. 
The deciding factors will be the plane height and normal orientation, the line direction, and the point position. 
Because Wireframe Checker was used to select the geometry, the nominal data for the features is already known. 

 If these values are unknown, then the Geometry Explorer  may need to be used to select the Feature locations. 
A Geometric PLP Alignment can now be created using these values: 

1 Select  to close Geometric Group 1. 

2 From the Alignments  flyout on the Item toolbar, select Geometric PLP  

3 Alignment . 
The Geometric PLP Alignment dialog appears and prompts you to specify the Plane, 
Line and Point. A Name for the alignment can also be specified here. 

 
4 In the Plane area, select Plane 1 from the drop-down list, and set the Orientated Normal to the Z/Z+. 
5 In the Line area, select Line 1 from the drop-down list, and set the Orientated Direction to the X/X+. 
6 In the Point area, select Circle 1: Centre from the drop-down list. If the Point Coordinate 

nominal values are not loaded, click  to load the data. 
7 Click OK to close the dialog and create the alignment item. 
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All the criteria for the Geometric PLP Alignment have been satisfied, and the alignment 
can be seen in the Sequence Tree. 

 The CAD View is updated, with the Geometric Alignment positioned correctly. 

 This view of the model from above (looking down the Z axis) shows the alignment. 

 The alignment can be seen more closely in the zoomed view of the bottom-right corner 
(below). 

 To test if the alignment is correct (if probe tracking is available on the system), move the 
probe around key points on the part and check the Graphics window to see if the 
representation of the probe is in the same place (see below). Any variation suggests an 
incorrect alignment, a failure in the probing of the items or an incorrect part in relation 
to the CAD. 



 3.  Alignments 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            15                                                                                                                             

 

8 Click  to save the inspection session. Name the file GeometricPLP.pwi and save it in any convenient location (e.g. C:\Temp).   
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Free Form Alignment 
Free Form Alignment  is considered to be relatively inaccurate because it relies on 
the skill of the user, but it is sometimes the only option if there are no clearly definable features for which CAD values are known (such as flat planes, circular forms etc.). 
 
Generating a Free Form Alignment  
For this example, the DemoBlock2008(CMM+Arm) file is going to be used. There are a 
number of geometric features on this part, but for the purposes of this exercise, these will be ignored and it will be assumed that there are no features.  
 

1 Click  to create a New Document using the Wizard. In the wizard, select Measurement 
with a single CAD part, and click Next. 

2 Browse for DemoBlock2008(CMM+Arm).dgk and click Open. 
3 Leave the offsets and tolerances unchanged, and click Next. The Variables page is displayed. 
4 Browse for an HTML Report Template. The report variables are displayed. 
5 Click Finish. 

The new session is now ready for inspection. 
 
Choosing the target positions 
When performing a Free Form Alignment, you need to carefully study the CAD model and physical part before deciding where to take the probed positions. For a Free Form 
Alignment the part needs to be held in position in all three axes (X, Y and Z). This holding should ensure that the part cannot move in a space through any translation or rotation. 
Taking the CMM Bed/Table as the surface on which to ‘pin’ the part, you need to choose 
a realistic minimum of six or seven points (this can be as low as four but the alignment is less accurate). In this case, six points will be used: 3 in the Z direction, 2 in the Y direction and 1 in the X direction. It is important to place these points in positions that will be easily found on the physical surface, such as in line with other parts of geometry, or key surface points. These will act as guides for the probing positions. 
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When you have selected the positions, it is time to create a Free Form Alignment: 
 

1 From the Alignments  toolbar in the Item toolbar, select the Free Form Alignment 
 button.  

 The Dynamic Point toolbar is displayed on the right of the screen. 

 This toolbar allows you to create the free-form Target Points, and to manipulate their 
positions, normal directions and offset values. 
 

 The Dynamic Point toolbar can also be accessed from the CAD View toolbar using 
the Dynamic Points Editor  button. Alternatively, you can access Dynamic Points editing options through the Tool > Dynamic Points option from the Main menu. 
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In the CAD view, the cursor has now changed to a Target Sight . This enables 
you to select the probing points on the CAD surface. Select points by double clicking on 
the surface of the model. The representation of the point can vary according to the view. 
For example:  

 
 View straight down 
 Isometric view 

2 Choose six key points (3 in Z, 2 in Y and 1 in X) on the part surface that can be easily found. Use key features to aim for such as lines, indents, corners and even projected aiming positions on the part. The points chosen on the part now need to be re-produced on the CAD file within 
PowerInspect. 

3 Replicate the points chosen on the part within the CAD View. Do this by double-clicking the Target cursor on the chosen surfaces to define the 6 points for alignment. 
With the Target Points selected, the CAD View should look something like this: 

 When you have created the points, you can change their position and orientation, or 
delete and recreate them. 
Hold the Target Cursor over any of the chosen points and the cursor changes to a hand 

. This allows you to select and move the point around the surfaces using Dynamic 
Points Selection, which can help you find positions that are more easily probed (lining 
up with feature, for example).  
The Dynamic Points Selection also lets you choose the points to be manipulated using 
the other Dynamic Points Editor toolbar functions. 
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Using the Swap Normals  button allows you to reverse the direction of the points. 

 
 Normal To Surface 
 Normal Reversed 

This can be useful if the user-defined point has been created in the wrong direction, or if 
the probed point is in an inaccessible position, for example, the underside of a surface. 
Using the Switch Surface/Edge Point  button allows you to flip the surface point 
onto the edge if the point chosen is close enough to the edge. 

 
 Surface Point 
 Edge Point 

This is used when edge points are required rather than surface points. 
 The point label changes from an S (Surface) to an E (Edge).  

Using the Apply Offset  button allows you to set an offset value for the probed 
position. 
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 Without Offset 
 With Offset (value in brackets) 

This is useful for inspecting pressings, whereby a known uniform thickness of material 
allows user to inspect the underside of a pressing, taking into account that thickness. 
 Once the Target Points have been selected and manipulated, the Free Form 
Alignment can be created ready for probing. 

4 Select Delay Measure  button from the Main toolbar. 

5  Click the Create Free Form Fit Alignment  button from the Dynamic Point 
toolbar. The Free Form Fit Alignment dialog appears indicating the Positional Coordinates of 
each chosen point, the Surfaces they lie on, and the Offset values. 
 

 Within this dialog, you can specify the Point Projection Proximity Criteria, which 
define the area of search around the probe. 

6 Increase the Point projection proximity criteria to 3 mm and click OK. 
A Free Form Fit Alignment item is created in the inspection sequence. 

 This is the Free Form Alignment created from the Target Points, and will be used for 
probing the part. 
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 The cross icon next to Free Form Fit Alignment 1 signifies that the alignment has not yet been probed or played. 
7 Right-click Free Form Fit Alignment 1 to display the context menu. 

 

 
8 Select Play Item. 

Alternatively, click the Play Item  button on the Main toolbar. 
The Probing Screen is displayed allowing you to probe the pre-defined target points. 
 
Probing the Part 
When you click Play Item, you enter Full Screen Measure Mode and you can probe the part. In this mode, a Probing dialog is displayed, with the target number shown (e.g. DS 1) and a series of probing option buttons. These buttons are the same as those displayed when probing the Geometric PLP Alignment, except that the Reset All has gone, and the 
Parameters  button (which shows the CAD Context and Proximity Criteria for the 
probed points) is shown. 
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The Dynamic Point Target  is displayed, and this is where the skill of the user comes in, because you must probe as close to the targets as possible. The targets appear in sequence order and as each one is probed the next one is displayed on the screen. 
1 Probe the 6 points to complete the alignment. 

 
 Always check the screen at each point to make sure the correct position is being probed. To achieve a more accurate result, aim for within +/- 3mm of the target point. 

 The probing dialog indicates that there are no more points to take when you have probed 
all the defined target points. 
 

  

2 Select  to accept the alignment. PowerInspect calculates the alignment.  
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When the calculation is complete, PowerInspect exits the Full Screen Measure Mode. 
The less time this takes, the better the alignment tends to be. 
 
In the Inspection sequence, the cross  on the Free Form Fit Alignment item has 
changed to  too indicate it is now measured. 
 

  
The Demoblock2008(CMM+Arm) part has now been aligned using the Free Form Alignment 
method. 
To check this alignment (if probe tracking is available on the system), move the probe around key points on the part and check the Graphics Window to see if the representation of the probe is in the same place. 

  
If not, it may be necessary to either re-probe the part, or check the probe configuration for error mapping. 
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Generating a Surface Inspection Group 
When the part is correctly aligned to the CAD file, the next stage is to create a surface inspection group. This group will be used to check the accuracy of the Free Form 
Alignment, and to improve the alignment using the Best Fit Analyser, so it is not necessary to include this initial group in the Report. 

 Surface inspection will be covered in greater detail in a later chapter. 

1 Make sure the Delay Measure  button is selected. 

2 Create a Surface Inspection Group using On the Fly Surface Points  from the Inspection 

Groups flyout  found on the Item toolbar. 
 

  
3 In the Surface Inspection Group dialog, deselect the Output in Report check box and leave the other settings unchanged. 
4 Select the Auto-accept enabled check box and then set the Points to 12. Leave the other settings unchanged and click OK. 

5 Right-click the Surface Inspection Group  icon in the inspection sequence and select 
Play Item. 
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6 Probe 12 surface points on the part, 4 in Z, 4 in X and 4 in Y keeping a wide spread. As you probe the points, the Surface Points on the Fly dialog displays the deviation of 
the measured points. 

 
 If no points are being registered, it may be necessary to increase the proximity criteria to help detect them. 

7 When you have probed 12 points the exclamation mark icon in the inspection sequence, 
is no longer displayed on the Surface Inspection Group  icon. 

8 Double-click on the Surface Inspection Group to open the group and verify that 12 points 
have been probed.  
 

   
If the points have a wide deviation, it may be necessary to re-probe the alignment. The 
Best Fit Analyser may be able to correct this, but the key is in recognising the whether 
or not a Best Fit will work. 
For example, if positive deviation can be seen on one side of the part, and negative 
deviation on the other side (each of the same value), this suggests a slight translation. 
Similarly, opposites around an axis indicate a rotation. If this sort of pattern can be seen, 
a Best Fit will improve the results. 
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Generating a Line of Best Fit 
Because of the dependence on the skill of the user, a Free Form Alignment may need some fine-tuning to generate a better alignment. PowerInspect contains a Best Fit optimisation option, which allows you to generate a line of best fit between the probed points, and to align the CAD model and the part more accurately. 

 The Best Fit Optimisation option should only be used on the Free Form alignment. Attempts to use it on an alignment based on geometric data may cause a distortion of the results. In addition, Best Fit optimisation should be used only once on each Free Form inspection. 
 
For this example a Best Fit optimisation is applied to the newly created surface inspection group: 

1 Select Up One Level  in the Sequence Tree to close the Surface Inspection Group.  

2 From the Alignments  toolbar, select Best Fit . The Edit BestFit definition dialog is displayed. 

  
This dialog allows you to Name the item, to specify the fitting Method, and to select 
items to be used to calculate the best fit. 
 

3 In the Method drop-down list, select Translation and Rotation. 
4 Click to highlight Inspection Group 1 from the Available Items list, and select it using the 

 button. 
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5 Click Apply, then OK. The Best Fit Analyser is displayed. 

 

 If Delay Measure  is selected, right-click on the Best Fit Icon  in the Inspection sequence and choose Play Item to start the Best Fit Analyser. 
 A graphical display of the current points’ deviation is given (green line) along with the 

information used for the calculation of the Best Fit. 
6 Leave the settings unchanged and select the Go Step! button. The Best Fit Optimisation is applied to the data and the new deviation graph (red line) 

fits closer to zero. 
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7 Select OK to accept the optimisation. The Best Fit has brought the results closer to zero, creating a more accurate alignment. 
 

 Some results may be anomalous and may need modification or further inspection. 
 

Clicking the  button will switch the view between original data with best fit and just 
the best fit. The scale changes accordingly. 

8 Re-open the Surface Inspection Group to verify that the deviation results have improved. 
With the alignment created, and best fit applied, more surface inspection groups can now be taken. Since all items are created with respect to the Best Fit, further best fitting is not required. However, should the results of the alignment not be accurate, it may be necessary to re-align the part.   
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RPS Alignment 
The Reference Point System (RPS) alignment is a technique developed by Volkswagen 
and has now become an industry standard for inspection. As an alignment technique, its method lies somewhere between a Free Form alignment and a Geometric alignment, 
combining the benefits of both, with the ability to accept geometric positional data and surface points. 
For the purposes of this training course, the use of geometric data will be emphasised, utilising the Geometry Explorer to find positional points in the CAD model. 
Generating an RPS Alignment  
Using the methods previously described in the course for starting a new session: 

1 Click  to create a New Document using the Wizard. In the wizard, select Measurement 
with a single CAD Part and click Next. 

2 Browse for Demoblock2008(CMM+Arm).dgk. 
3 Leave the Offset and Tolerance settings unchanged, and select Next. 
4 In the Variables dialog, browse for any HTML Report Template (Excel could be used, but for this example HTML is to be used). 
5 Click Finish. 

Choosing the Geometric Elements 
As with the previous methods, you must decide which geometric features will determine the alignment. In this example, the part will be aligned using a series of probed circles, each with their own locally probed plane. The centres of these circles will then be used to determine the RPS alignment. The Geometry Explorer will be used to create these circles. 
The Geometry Explorer 
The blank Geometry Explorer is shown below. As each feature is selected in the CAD view, its details appear in the tab. 
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The Geometry Explorer can be used in two ways: as a measuring device, providing CAD nominals for geometric alignments; and as a selection tool, selecting the geometric items you want to probe. 

 The Geometry Explorer and Features tabs can be hidden by toggling  at the top of the Sequence Tree. 

To select an item, select the Wireframe Checker  button in the Mouse Context toolbar, then hold the cursor over the feature in the CAD model until its wireframe is highlighted yellow, then left-click to select it. 
The chosen item is highlighted in red, with its details displayed in the Geometry Explorer. 
 

  
The details are displayed in the top portion of the explorer, and by moving down the levels (using the  icon), you can view and copy specific values, like the Arc Centre Point 
for example. 
 

  
These values can then be used to determine CAD nominals for a Geometric PLP Alignment. 
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In this chapter, the Geometry Explorer is used to select the geometric items to be probed. The part is to be aligned using a series of probed circles, each with their own locally probed plane. The circular holes are located at each corner of the part: 

1 Click  to orientate the view so that all the circles can be seen. 

 

2 Select the Delay Measure  button.  

3 Select Wireframe Checker . 
4 Right-click in the CAD view and select Wireframe from the context menu.  

 
5 Move the cursor over circle 1. When it is highlighted in yellow, click to select it. The colour changes to red. 

 
6 In the Linked to drop-down list of the Geometry Explorer, select Most suitable plane. 

 

7 Click  to accept the feature. 
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 If an individual plane (or the correct plane) is not assigned to a feature, you can create a new plane by selecting New Probed Plane before accepting the feature.  

 PowerInspect creates a Plane and Circle to be probed. This can be seen in the second 
portion of the Geometry Explorer and in the inspection sequence. 

 
 The crosses  next to the Geometric Items indicate that the items are not yet measured. 

 In the CAD View the created Local Plane and Circle can be seen. 

 
8 Repeat this process for the other two circles. 

 

  
The Sequence Tree displays the six items (three Planes and three Circles), which can also 
be seen in the CAD View. When the part is securely fixed to the CMM bed, these items 
are ready to be probed. 
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9 Right-click any item in the inspection sequence and select Play All from the context menu. 
Alternatively, click the Play All  button on the Main toolbar. 
As with the Geometric PLP alignment, the first Feature Probing dialog appears asking 
you to take a minimum number of points to define that feature. 
 

 
10 Probe three points around the Plane shown on the screen. 

 

 

11 When the points have been probed, click . The next item is displayed. 



               3. Alignments         
 

                                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

34                                                                                                                                                                      Copyright © Autodesk                                                                                                                                                      

12 Continue the probing process until all items have been probed, making sure to probe them in the order that they are shown.  
When all the items have been probed, the inspection sequence is updated. 

  
The CAD View now contains the probed planes and circles, which require an alignment. 

 

 If the probed items can’t be seen, click  to resize the screen to fit, because the items may lie some distance away at this stage. 
 

Generating an RPS Alignment 
An RPS alignment will now be used to align the CAD model to the part. 

1 Click  to close Geometric Group 1. 

2 From the Alignments  toolbar in the Item toolbar, select the RPS Alignment button 
. The RPS Alignment Definition dialog is displayed.  
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The items used for the alignment are selected in the drop-down menu . After an item 
is chosen, other items can be added using the  button. 

 
3 Leave the Name and Local Datum unchanged, and select Circle 1:: Centre to specify the first position from the pull-down menu. 
4 Select the  icon, to display a new drop-down menu. From the new menu, select Circle 

2::Centre to specify the second position. 
5 Repeat the process for Circle 3::Centre. 

 
 The check boxes allow you to lock and unlock axes relative to particular items. This enables you to create a 3-2-1 alignment. 

6 Click Apply and then OK. If all check boxes are selected, the RPS alignment is over constrained and behaves 
similar to a best fit. 
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PowerInspect aligns the probed positions to the CAD points given, satisfying X, Y and Z coordinates. 

 
The CAD View is updated, with the Probed Items having been aligned to the CAD Data. All the criteria for the RPS Alignment have now been satisfied, and the alignment can be 
seen in the inspection sequence. 

 
To check the alignment has worked, choose a variety of views and zoom into the aligned items to see if they match up. 

For example, in this picture, a view looking down the Z-axis  zoomed into one corner, the alignment can clearly be seen. 

 
To test the alignment is correct, move the probe around key points on the part and check the Graphics Window to see if the representation of the probe is in the same place. 
If the alignment is correct, Inspection Groups can then be produced. Inspection will be discussed in the next chapter. 
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Best Fit From Points Alignment 
The Best Fit From Points alignment  can be used to align from three or more points 
for which the CAD coordinates are known. PowerInspect uses these points that have been probed as geometric items to carry out a best fit to the rest of the CAD data. This method allows you to modify the alignment later, if necessary, by amending the details of the geometric items. 
Before you use this alignment, you must create geometric items that provide at least three points. Points include centres of geometric items, such as the centre of a circle or sphere. You must also know the nominal position of the points: if you do not have this information, you can extract the coordinates using the Geometry Explorer tab. This method is shown below. 
 

 A Best Fit alignment can produce the same results as a Three Spheres alignment if three spheres are used to supply the three points. A Three Spheres alignment uses tooling balls; it is predominately used in the aerospace industry. 
 
Generating a Best Fit From Points Alignment 

 

1 Click  to create a New Document using the Wizard. In the Wizard, select Measurement 
with a single CAD part and click Next. 

2 Browse for Demoblock2008(CMM+Arm).dgk and open the file. 
3 Leave the offsets and tolerances unchanged, and click Next. The Variables page is displayed. 
4 Browse for an HTML Report Template. The report variables are displayed. 
5 Click Finish. 
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Choosing the Geometric Items 
As with the previous methods, you must decide which geometric items will determine the alignment. In this example, the part is to be aligned using a series of probed circles, each with their own locally probed plane. The centres of these Circles are then used to determine the Best Fit points. 
As in the previous example, the Geometry Explorer is used in conjunction with the 
Wireframe Checker  to select the items. 

 

1  Click  to orientate the view so that all the circles can be seen. 

2 Select Delay Measure . 

3 Select Wireframe Checker . 
4 Right-click in the CAD view and select Wireframe from the context menu.  
5 Select the top wireframe of Circle 1. 
6 In the Geometry Explorer, select Most suitable plane in the Linked to drop-down list. 

 

7 Click  to accept the feature. 
 If an individual plane (or the correct plane) is not assigned to a feature, you can create a new plane by selecting New Probed Plane before accepting the feature. 
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PowerInspect creates a plane and circle to be probed. This can be seen in the Geometry 
Explorer and in the Sequence Tree. 
 

 
 The exclamation marks  next to the Geometric Items indicate that they are not yet measured. Looking at the CAD View, the created Local Plane and Circle can also be seen. 

 

  
8 Repeat the selection process for Circle 2. 
9 Select the Circle 3 wireframe. In the Geometry Explorer, change the Circle option to Single 

Point Circle before clicking . 
 

  
The Sequence Tree and the CAD view display the six items (three Planes, two Circles and 
a Point). With the part securely fixed to the CMM bed, these items are now ready to be 
probed. 

10 Right-click any item in the inspection sequence and select Play All from the context menu. 
Alternatively, click the Play All  button from the Main toolbar. 

11 Probe all features as directed. 
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Generating a Best Fit From Points Alignment 
1 Select  to close Geometric Group 1. 

2 From the Alignments  toolbar, in the Item toolbar, select the Best Fit From Points 

Alignment  button. Point 1/3 is displayed. 

 
3 Select Circle 1: Centre from the drop-down list. You can type the X, Y and Z Coordinates for Circle 1: Centre. Alternatively, because the 

nominal values have been extracted from the CAD model using Geometry Explorer, 
you can enter them using the Load Nominal button. 

4 Select Load Nominal to load in the nominal values for the circle centre. 
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 You can make the first point a hard point by selecting the Hard Point check box. This means that PowerInspect will match the geometric point to the CAD nominal exactly rather than trying to best fit it with the other features. This option will not be used in this example.  
 

5 Select  to display Point 2/3.  
6 Select Circle 2:Centre and then select Load Nominal.  
7 Select  to display Point 3/3.  
8 Select Point 1:Centre and then select Load Nominal.  
9 Select OK to create the Best Fit alignment. 

 
 A minimum of three points are required for the alignment. You can add more points 

by selecting New .  
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4.  Datums 
Datums (origins) are reference points on a part. Additional datums can be created within an inspection sequence to reference features whose dimensional properties are relative to the datum.  
Before you create a datum, you will need an aligned part. Before starting the following examples, load the Demoblock2008(CMM+Arm).dgk part and align it using the Geometric 
PLP aligment, described in chapter 3. 
 
Datum toolbar  
The Datum toolbar is available from both the Item and Geometric toolbars. 

 
There are six methods for creating a datum in PowerInspect: 

 Create a datum.  
 

 Create a datum by shifting the origin of an existing datum to explicit CAD coordinates, or to a point feature. 
 

 Create a datum by rotating an existing datum around one of its axes by a specified angle.  
 

 Create a datum by aligning an axis of an existing datum to the vector of a specified 3D item. 
 

 Create a datum by aligning an axis of an existing datum to the vector of a specified 2D item. 
 

 Create a datum by applying a transformation matrix to an existing datum. 
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Creating a datum 
1 Select the light bulb icon of the PCS (CAD Datum) in the Sequence Tree to display the 

default datum . 

 

2 Select Datum  from the Datum  toolbar. The Datum dialog is displayed. 

 
3 Complete the dialog as shown above and then select OK. 

 

 
A new datum, Datum 1 , is created at the centre of Circle 1. 
The original datum, PCS , is still shown. 
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Creating a shifted datum 
There are two methods you can use to create a shifted datum. 
To explicitly define the datum position: 

1 Choose Shifted datum  from the Datums toolbar. 
2 Enter the coordinates as shown in the dialog: 

 

  
3 Select OK to create the new Datum. Datum 2 is shown in the CAD view. 
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To base the datum position on a feature 

1 Choose Shifted datum  from the Datums toolbar. 
2 Select Based on feature from the Method drop-down list. 
3 Select Circle 2::Centre as the feature. 

 

  
Ensure PCS (CAD Datum) is selected as the Datum required to shift. 
 

4 Select OK to create a new datum. 
 
All datums created are shown in the Sequence Tree: 
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Creating a user-defined Datum 
Use the user-defined datum button to create a datum by applying a transformation matrix to an existing datum. 
 
To create a user-defined datum 

1 Click  on the Datum flyout. The User-defined Datum dialog is displayed. 
 

  
2 In the Datum drop-down list, select the datum to which you want to apply the transformation. 

Alternatively, click  to select a datum from the CAD view using the cursor. 
3 Select Datum 2 and click Translation. The Translation dialog is displayed. 
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4 In the X box, enter -80 and click OK. The User-defined Datum dialog is updated. 
 

  
5 Click Apply, then OK to close the dialog. A new datum  has be created on the CAD 

model at the specified translation from Datum 2 . 
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Using Datums as local coordinate systems 
 
Datums can be specified as the local coordinate system for individual inspection groups, section groups, point cloud groups, and point clouds using the Coordinate system list in each item’s definition dialog. This enables you to create reports where points are measured relative to any point on the part.  
 

 
 
When the Coordinate system of a group is changed from a datum, it has the following effects: 
 
 Nominal target points move on the CAD model. This may cause them to become invalid when you change the definition of the datum, or when you change measures. 
 Measured points remain in the same place on the CAD model, but are reported using the new coordinate system. 
 For section groups, coordinates are reported in the new coordinate system.  
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5. Inspections 
This chapter describes the main inspection techniques available in PowerInspect. After creating a suitable alignment, the part can be inspected against the CAD data. This measures the accuracy of the part and highlights any errors (deviations outside the specified tolerances), assuming the CAD data is correct.  
The tolerance values, which are used by inspection groups, can be changed globally (though the use of the Start-up Wizard, or Measures > Parameters menu option), or individually in each inspection group. 
 
Surface Inspection Group – Points on the fly 

1 Click New Document Wizard  to open the New Inspection Session wizard.  
2 Select Measurement with a single CAD part and click Next. 
3 Click New and browse to DemoBlock2008(CMM+Arm).dgk. 
4 Leave the offsets and tolerances unchanged, and click Next. The Variables page is displayed. 
5 Browse for an HTML Report Template. The report variables are displayed. 
6 Click Finish. 
7 Create an alignment using one of the previously learnt methods. 

 
The new session is now ready for inspection. 
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1 Deselect the light bulb for Geometric Group 1 . This removes the contents of the group from the CAD View, making it less cluttered when taking the surface inspection.  

2 Click the Surface Inspection Group   and then select On the fly Surface Points . 
 

  
With this dialog, you can determine the name of the group, choose whether to take 
surface points, edge points, or hem edge points, and choose whether to take points on 
the fly or guided points. You can also specify the minimum number of points to be taken, 
as well as setting counter values, labels and adding comments. 
This dialog also allows you to change the local offsets and tolerances for the group; to 
specify whether the group is included in the Report; to rename the points in the group; 
and to change the point counter and its increments. 
In this example, the dialog is used to create a group in which points are taken on the fly. 
 

3 Select the Output in Report check box, leave the other settings unchanged, and then click 
OK. 
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If Delay Measure is selected, you can display the Surface points on the fly dialog by. 

 right-clicking the inspection group  icon in the Sequence Tree and selecting 
Play Item from the context menu. 
 or 

 selecting the inspection group in the Sequence Tree and clicking Play Item  on the Main toolbar 
 
The Surface points on the fly dialog is displayed. A minimum number of points (set in 
the Surface Inspection Group dialog – in this case 6) need to be taken to satisfy the 
inspection. 
As the points are probed the Surface Points on the Fly dialog displays the deviation of 
the measured points. These are displayed in all three axes, dX, dY and dZ, as well as a 
resultant deviation, dL. 

  
This dialog has similar options to that of the Feature Probing dialog with addition of a 

Suspend Recording  button, which allows you to see the points without recording 
them. 
There is also has a Parameters  button. Click this button to display the Measure 
Parameters dialog, which contains a summary of the parameters used for inspection 
points and guided points (such as proximity criteria, which may need to be increased if 
points are not registering). 
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4 Probe any number of points on the part surface, making sure to satisfy at least the minimum number of points set in the Surface Inspection Group dialog. 

 

5 When you have taken enough points, click .  
6 Select the Report tab to view the surface inspection group results. All the items chosen 

to be output to the report are displayed; scroll down the report to view the inspection group results. 
 

 To export the report so that it can be viewed in a web browser,  

click Export Report  on the Main toolbar, and save the report as Report.mht. 
 
 

7 The results can also be viewed from within the CAD View and the Sequence Tree. To view the points that have been taken, select Inspection Group 1 in the Sequence Tree and 
click the Open Group  button, or select Open Group from the right-click popup menu. 
 

 Using the  button to open the group displays the points in the Sequence Tree, but does not display the statistical data in the Print Preview. To view this, the group must be opened. 
 

 When the group is open, the points can be individually highlighted, deleted or modified (For further details, see Chapter 9 Modifying Elements). Double-click on a point to open the Guided Point dialog which displays its position, deviations and so on. 
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8 By default, an open group is sorted by the number label of the points taken (SP-1, SP2, SP3, etc….). Right-click anywhere inside the group and select Sort by Deviation from the 
popup menu. 
 

  
This sorts the points by the amount by which they deviate from zero, starting at the 
lowest and working up to the highest deviations.  
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Surface Inspection Group – Edge Points 
You can use PowerInspect to inspect edge points.  

1 Click  to create a New Document using the Wizard. In the wizard, select Measurement 
with a single CAD part, and click Next. 

2 Browse for Demoblock2008(CMM+Arm).dgk and click Finish to open the file. 
3 Create an alignment, using one of the previously learned methods. 

4 Click Delay Measure . 

5 Click the Surface Inspection Group   and then select On the fly Edge Points . 
 

  
6 Ensure Output in Report is selected, leave the other settings unchanged, and then click 

OK. 

7 Select the Surface Inspection Group  icon that has now been added to the Sequence 
Tree and click Play Item . 
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 The Edge Points On the Fly dialog is displayed. A minimum number of points (in this 
case 6) must be taken to satisfy the inspection. This number can be defined on the 
Surface Inspection Group dialog. 
Using this method, PowerInspect requires two probed points to define the edge to be 
inspected. 

8 Probe a point on the surface near the edge you want to inspect. 

 PowerInspect displays a yellow mark to represent the point and a yellow triangle marker 
to indicate where the second point must be probed. 

 The co-ordinates of the edge point are displayed on the left of the dialog. 

 
9 Probe the edge indicated by the marker to record the edge point. 
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 The point must be probed precisely. The proximity criteria can be changed by 
selecting Parameters  from the Edge Points on the Fly dialog. 

 When the point is probed, the deviation is indicated on the right of the dialog. 

  
10 Repeat the process above to take five further edge points. 

11 When probing is complete, click .  PowerInspect displays the edge points on the model as triangles. The colour scheme used 
by the triangles to represent the deviation is the same as that used for Confetti. You can 
customise the display by displaying labels, for example.  
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Edge points - Single point option 
Use the single point option to create edge points using one touch. This method is faster, but potentially less accurate. 
 

1 Follow points 1 to 8 in the Edge Points On The Fly section. 

2 Click Parameters  on the Edge Points On the Fly dialog. 

 
3 Select Single point measurement. 

 
4 Click OK. 
5 Probe a point on the surface near the edge you want to inspect. A triangle is displayed to show that the point has been recorded.  

  
The deviation of each point is displayed on the right-hand side of the Edge Points On 
the Fly dialog as it is probed.  
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6 Continue probing the edge until you have taken the required number of points. 

7 When probing is complete, click . 
 

 PowerInspect displays the edge points on the model as triangles. The display can be customized by displaying labels, for example. The triangles represent the deviation using the same colour scheme as Confetti. 
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Surface Inspection Group – Hem Edge Points 
The Surface Inspection Group dialog contains a Hem edge points option that enables you 
to measure a rounded edge on a part. 
To create a surface inspection group to measure a hem edge. 

1 Click the Surface Inspection Group   and then select On the fly Edge Points . 
2 Click Page 2 and the folllowing dialog box is displayed below: 

 

  
3 Select Hem edge points, and enter the radius of the edge  and the thickness of the 

surface  in the Surface Offset box. 
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 If the surface is to be probed from the top, enter the surface offset as a positive value. If the surface is to be probed from the bottom, enter the surface offset as a negative value. 
 

4 Complete the dialog and click OK to save your changes. 
5 The nominal position of the hem edge is calculated as the sum of the Radius and the 

Surface offset . 
 
Probing the Hem Edge 
For each hem edge point measurement you want to make, you must probe two points: 
 
 The first point  must be located on the nearest surface of the CAD model. This sets the nominal plane and direction used to calculate the position of the hem edge point. 
 The second point  must be located on the edge itself. It is projected on the nominal 

plane  to determine the actual position of the hem edge . 
 
PowerInspect then uses the projection and the hem-edge nominal position  to calculate the deviation parallel to the nominal plane, and perpendicular to the nominal edge 
direction .  
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Surface Inspection Group – Guided Points 
There are a number of ways to create a surface inspection from guided or targeted points. 
Guided points can be used to check the accuracy of a feature for which the CAD coordinates are known.  
Using the Dynamic Points Editor 

1 Select  to create a New Document using the Wizard. In the wizard, select 
Measurement with a single CAD part, and then click Next. 

2 Browse for Demoblock2008(CMM+Arm).dgk and click Finish to open the file. 
3 Create an alignment using one of the previously learnt methods. 

4 Select the Dynamic Points Editor  from the Mouse Context toolbar. 

 The cursor changes to a target sight  in the CAD view. This allows you to select the points on the CAD surface that are to be inspected as guided points. 
Points are created by double-clicking on the surface of the CAD model.   

5 Create a number of target points on the model as shown below. 
 

  
6 From the Dynamic Points Editor toolbar, click Create a Guided Surface Inspection Group 

. 
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The points are added to a surface inspection group in the Sequence Tree. 

 

7 Select Play Item  from the Main toolbar. PowerInspect switches to full-screen 
measure mode, and the first dynamic point to be probed is identified by the target icon 

. As you probe each point, the target moves to display the next point in the inspection sequence. 
 

  
 As you move the probe, a green bar at the bottom of the Guided Points dialog indicates its proximity to the target.   

Only points that are within proximity criteria specified in the Measure Parameters 
dialog are accepted. To view or modify these parameters, click . 

 
8 Probe all points in the order indicated. 
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9 Check the results in the Report tab. 
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Manually Entering Points 
You may need to control exactly where points are positioned on a part. This can be accomplished using the Guided Point dialog to manually input coordinates or edit existing 
coordinates. An advantage of this method is that you can ensure repeatability. 

1 Ensure Delay Measure  is selected. 

2 Click  to open the Surface Inspection Group dialog. 

3 Select Guided Surface Points Click OK. 
 

  

4 Click  to open the empty Surface Inspection group. 
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5 Click . The Guided Point dialog is displayed. 
 

  
This dialog allows you to modify existing points or enter new coordinates to create points. 

6 Enter the following co-ordinates in the Target Point area: X 10, Y 15, Z 0. 
7 Select the Accurate coordinate option.  

 The option Project point along direction can be used to project points (approximate values known) onto the surface in the direction defined.  

 
8 Click Calculate Now then click OK. The point is positioned on the surface at the specified coordinates. 

 
9 Repeat the process two more times and enter the following coordinates : 
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 X 55, Y 80, Z 0 Click Calculate Now & X 60, Y 0, Z -10 and select the direction 

 Click Calculate Now.  

10 Select Play All  from the Main toolbar. 
11 Probe the points in sequence order. 
12 Check the measurement results in the Report tab. 
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Introduction to Section Inspections 
You may want to perform an inspection of a cross-section across a part. PowerInspect allows you to create section lines, in any direction, along a surface. These sections can then be probed to inspect the deviation of that surface, in relation to the CAD data. 
Preparing a session for section inspection 

1 Select  to create a New Document using the Wizard. In the wizard, select Measurement 
with a single CAD part, and click Next. 

2 Browse for Demoblock2008(CMM+Arm).dgk and click Finish to open the file. 
3 Create an alignment using one of the previously learnt methods. 

 If you already have a session open, this can be used for the section inspection without the need to start a new session. 
At this stage, with the CMM aligned to the CAD data, you would manipulate the view to choose where to take the section. However, for the purposes of this exercise, a section is going to be taken in the X plane (in the face of XZ) at a distance of X=200. 

 
 
Generating a Section Inspection 
To inspect a sectional area you must define the section to be probed. 

1 Select Delay Measure . 

2 From the Item toolbar click Section Group . 
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 The Section dialog box is displayed as shown below. 

  
 If you click the Transform button, you can input a Rotation or Translation of the 

Section Line. 
 

3 In the Cut plane area, set the Plane to X, and enter a Coordinate distance of 200. 
4 Leave the other settings unchanged, and click OK. The section line is displayed in the CAD View, and a section group is displayed in the Sequence Tree. 
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When a section group is created, a new Section Group tab appears below the graphics 
window . Select this tab to open the Section view. 

 
 You can reorient the view by pressing the arrow keys on the keyboard (for mirror moves) and by pressing Page Up (anti-clockwise) and Page Down (clockwise) keys for 5-degree rotations. 

Using the Shift key in conjunction with the Page Up and Page Down rotates the view by 90 degrees. 
 With the part securely fixed to the CMM bed and aligned, the Section Group is now 

ready to be probed. 
5 Orientate the view so that the section may be easily taken (for example, down the Z 

Axis). 

6 Click the Section Group to highlight it in the Sequence Tree, and click Play Item . PowerInspect enters full screen measure mode, and the Section Inspection dialog is 
displayed. The Section Inspection dialog displays information about each point as you probe along 
the section line. 

 It is up to you to aim the probe along the section line and probe any number of points to measure that section. This can be done easily if your CMM has lockable axes, however if this is not available, then PowerInspect has some useful tools to help. 
 

 

7 In the Full Screen Options toolbar on the right of the screen, click the Tracking Box  button. 
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The Tracking Box is displayed, allowing you to see a numerical representation of the 
probe position. Because the part is aligned, the tracking can be set to the CAD 
Coordinates to monitor the X=200 value. 

8 In the drop-down list of the Tracking Box, select CAD Co-ordinates. You can now use the Tracking Box to check the probe position is as close to X=200 as 
possible. 

  
However, to keep the probe at X=200 can prove very difficult if the axes cannot be 
locked, so you must specify a wider range (around X=200) in which to obtain probed 
positions. 

9 In the Section Inspection dialog, click the Measure Parameters  button. 
10 Select the Inspection Point tab at the top of the dialog. 

 

  
 This dialog allows you to increase or decrease the search parameters for inspection points for both Surfaces and Edges. 

Since this is a surface inspection, changes will only be made to the Surface Points. 
 

11 Change the Proximity Criteria, and the Maximum distance for guided points to the same value (in this example, the value is 5). 
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 PowerInspect will now allow points to be probed for the X=200 line at a minimum of X=195 and a maximum of X=205. 
 

12 Probe along the X=200 line as accurately as possible. 

13 When you have probed all the required points, click .   

  
When the section group is opened, the points are displayed in the Sequence Tree each 
with their corresponding deviation as shown below. 
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Section View 
 

1 Select the Section Group tab to open the Section View. 
 

 The above Section View is shown with the deviations as vectors. You can choose 
whether to display the results as Vectors , Pins  or Linked Pins  using the 
Section View toolbar. 
 

 

2 Click Print Preview  to view how the printed output would appear. 
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Geometric Feature Inspection (using Wireframe Checker) 
The Wireframe Checker  button allows you to pick geometric features directly from 
a model in the CAD view. The details of the feature you select are automatically shown in the Inspect dialog for that feature. The Wireframe Checker works in conjunction with the Geometry Explorer tab. 
 
The Wireframe Checker has the following picking modes. 
 

 
 
To change the picking mode, right-click an empty area of the graphics window and select a picking mode from the popup menu. Select. 
 
 Surface to pick a whole CAD surface. If the surface is part of a complex 3D-wireframe entity, PowerInspect extracts the entity's details. 
 Wireframe to pick a complex 2D-wireframe-entity, such as a slot. PowerInspect 

extracts the arc at each end and the line on each side and displays their details in the 
Geometry Explorer tab. You can also use this mode to select arcs (circles). 

 Simple Wireframe to pick a single component of a complex 2D-wireframe entity, such 
as the arc at the end of a slot. You can also use this mode to select arcs (circles), lines and points. 

 Points to pick single points on the CAD wireframe. If you pick two points, 
PowerInspect constructs a line. If you pick three points, PowerInspect constructs an arc. The point is very useful when the CAD has been drawn using trimmed entities which can be difficult to select. For example a slot can be made up of two circles and two tangent lines that are trimmed. 

 GD&T (Geometric Dimensioning and Tolerancing) to pick GD&T items from the CAD model.  
 
 GD&T mode applies only to models containing GD&T information, such as those saved in CATIA and Unigraphics files. 

When an item is selected from the CAD model, the Nominal data is displayed on 
the Geometry Explorer tab. When you click  to accept an item, PowerInspect creates a new item in the inspection sequence. 
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Feature Inspection Example 
1 Select  to create a New Document using the Wizard. In the wizard, select Measurement 

with a single CAD part, and click Next. 
2 Browse for Demoblock2008(CMM+Arm).dgk and click Finish to open the file. 
3 Create an alignment using one of the previously learnt methods. 

4 Click Delay Measure . 

5 Click the Activate sequence items  button from the Geometry Explorer tab. 

6 Click Wireframe Checker . 
7 Right-click an empty space in the CAD view and select Surface from the local menu. 

 

 

8 Select the central cone feature on the CAD model, and click  in the Geometry 
Explorer tab.  
 

  
The feature has been added to the Sequence Tree within a new Geometric group. 
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9 Select the Sphere feature on the CAD model, and then select  on the Geometry 
Explorer tab. 

 

10 Select the Cylinder feature on the CAD model and then select  on the Geometry 
Explorer tab. 

  
11 Right-click an empty space in the CAD view and change the picking mode to Wireframe. 
12 Select the Slot feature. In the Linked to list of the Geometry Explorer tab, select New Probed 

Plane and then select . 
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The Sequence Tree lists all items you selected. 
 

 

13 In the Main toolbar, click Play All . 
14 Select the Report tab to check the results on the Report page. 
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Geometric feature display  
In 5.9 Displaying data in the CAD view, various ways in which measurements can be displayed in the CAD view are shown. The measurement data of geometric features can also be displayed in a number of ways. 

The Geometry Feature Display toolbar  is available from the View Options 
toolbar. This provides a tolerance-based visual representation of the points taken to create the geometry. 
The following options are available. 

 — Deviation Lines 
 

 — Connected deviation lines  
 

 — Vector lines 
 

 — Discs 
 

1 Select the CAD View tab and zoom into the cone feature. 

2 Click Discs  on the Geometry Feature Display flyout. 
 

  
The probe points used to calculate the cone feature are displayed as colour-coded discs 
(green in this case, because all points are within tolerance). 

3 Select the remaining three options to view the results. 
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Combining measurements (Point sources) 
The Point Sources tab is available in the definition dialog of geometric items, inspection groups and section groups. It enables you to create a measured item using probed points from other items in the inspection sequence. For example, you can use this feature to create a cone by combining the probed points of circle items that measure different cross-sections of the feature. 

 
 

To create a compound item. 
1 Open the definition dialog of an unmeasured item. 
2 Select the Point Sources tab. 
3 In the Available sources list, select the items to be used to supply the probed points for 

this item, then click  to add them to the Selected sources list. 

  
4 Select OK to save your changes and close the dialog. 

The below icon is displayed on the item’s entry in the inspection sequence to indicate that 
it uses measurements from other items. 
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Simple Measures 
Simple Measures provides a quick and easy method of creating Geometric PLP alignments, and of measuring dimensions between features. With simple measures, PowerInspect automatically creates and plays all the items you need to make the measurement, so you can access the measurement immediately. 
To create a simple measure. 

1 Click the Simple Measures  button on the Item toolbar. 
 An alignment or CAD model is not necessary for Simple Measures. 

When Delay Measure  is deselected, clicking Simple Measures  connects 
to the measuring device and displays the Simple Measures Wizard. This allows you to 
quickly select the type of measurement required, and probe it immediately. 
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When Delay Measure  is selected, clicking the Simple Measures  button 
displays the Simple Measures toolbar. The icons represent the same functions as 
available from the wizard.  
You can then create the same simple measure items by clicking the corresponding 
buttons in the toolbar.  

 
2 Select a measurement type. The following measurements are available: 

 Alignments 

 — Creates a Geometric PLP Alignment defined by Plane, Line, and 
Perpendicular Line. 
 

 — Creates a Geometric PLP Alignment defined by Plane, Line, and Circle. 
 

 — Creates a Geometric PLP Alignment defined by Plane, and two Circles. 
 
 Distance Between Features 

 — Measures the distance between two points.  
 

 — Measures the distance between two planes.  
 

 — Measures the distance between the centres of two circles. 
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 — Measures the shortest and longest distances between two separate circles. 
 

 — Measures the minimum and maximum wall thickness between two nested 
circles. 
 

 — Measures the distance between a point and a plane. 
 

 — Measures the distance between a point and a line. 
 
 Angle Between Features 

 — Measures the angle between two planes. 
 

 — Measures the angle between two lines. 
 

 — Measures the angle between a plane and a line. 
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 Features 

 — Measures the points where a line intersects a circle. 
 

 — Compares group of probed points to the axis of a circle, and reports 
location and distance of the point nearest the axis. 
 

 — Compares group of probed points to the axis of a circle, and reports 
location and distance of the point furthest from the axis. 
 

 — Compares group of probed points to a plane, and reports location and 
distance of the point nearest the plane. 
 

 — Compares group of probed points to a plane, and reports location and 
distance of the point furthest from the plane. 
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Min/Max wall example 

1 Deselect Delay Measure . 
2 Zoom into the hole feature. 

 These two cylinders will be used to illustrate a wall thickness measurement. 
 

3 From the Item toolbar, click Simple Measures . The Simple Measures wizard is displayed. 
4 From the Distance Between Features section, select Min/Max wall thickness between two 

circles . Full screen measure mode is activated and the Feature Probing dialog is 
displayed. 

 

5 Probe the plane and then click  to accept the points. 
 

 



               5. Inspections         
 

                                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

36                                                                                                                                                                      Copyright © Autodesk                                                                       

 If the Auto accept  button is selected, PowerInspect automatically moves to the next item in the inspection sequence. 

6 Probe the outer cylinder and then click  to accept the points. 

7 Probe the inner cylinder and then click  to accept the points. 

  
The results are displayed on the screen. 
 

 

8 Click the Accept  button to reopen the Wizard, allowing you to take further measurements. 
9 Click Close to close the Wizard.  
10 Select the Report tab to view the results on the Report page. 
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Auto-extract, Auto-detect and Auto-accept 
PowerInspect includes options designed to help streamline the probing process. 
 Auto-extract nominals from CAD — PowerInspect automatically loads the nominal data of features as they are probed. 
 Auto-detect type for extraction — PowerInspect automatically detects the type of 

feature being probed when using Geometric Multi-Measure. This can be used in conjunction with Auto-extract nominals from CAD. 
 Auto-accept — PowerInspect automatically accepts items after a predefined number 

of points have been probed. 
All of these options require a CAD model and a valid alignment.  
 
Auto-extracting nominals 

 
An Auto-extract nominals from CAD button is available in the Feature Probing and Geometric 
Multi-measure dialogs. If activated, the nominal data is extracted and loaded from the 
feature. This provides an instant comparison (deviation and error) in the reported results.  

1 Select an unmeasured item in the inspection sequence, and click the Play Item  button in the Main toolbar. The Feature Probing dialog is displayed. 

2 Select Auto-extract nominals from CAD . 
 

  

3 Probe the item, and click  to save.  
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Auto-detecting features with Geometric Multi-Measure 
The Auto-detect type for extraction  button in the Geometric Multi-Measure dialog automatically identifies the features you are probing by comparing probed points to the CAD. Use it as a quick alternative to switching the item type each time you want to probe a different type of feature. 

1 Open a geometric group, and click the Geometric Multi-Measure  button in the Item toolbar. The CAD view switches to full screen measure mode and the Geometric Multi-
Measure dialog is displayed. 
If you want to display the coordinates and deviation of the points as you probe them, 

click the Point Details  button. 

2 Select the Auto-extract nominals from CAD  button and then select the Auto-detect 

type for extraction  button. 
 

 

3 When you have probed all the points for the feature, click  to save the points, and add the item to the inspection sequence or move to the next feature. 
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Auto-accepting items 
When the auto-accept  button on the Feature probing dialog is selected, PowerInspect 
saves your measurements as soon as you have probed the number of points specified on the probing dialog.  
You can modify the number of points required for different items on the Tools > Options 
> Probing options page.  
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4 Select an unmeasured item in an inspection sequence and click Play Item  to display the Feature probing dialog. 

5 Click Auto-Accept . The number of points that you need to measure is displayed in the dialog. 

 
 

6 Play the item. When you have probed the required number of points, PowerInspect saves the measurement and closes the dialog.  
 If you are playing more than one item, PowerInspect automatically plays the next item in the sequence. 
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Displaying data in the CAD view 
 
Geometric features and probed points can be displayed in the CAD view in several ways using the View Options toolbar. 

 

The Confetti  button displays the probed points as coloured spots. Points shown in green are within tolerance; points shown in red are above tolerance; and points shown in blue are below tolerance.  

 

The In Place  button displays the points as pins, with the length of each pin representing the amount of deviation. The pin colour also indicates whether the measurement is within, above, or below tolerance.  



               5. Inspections         
 

                                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

42                                                                                                                                                                      Copyright © Autodesk                                                                       

 

The Labels  buttons display measurement details of the geometric features and probed points. Labels can be displayed in conjunction with Confetti or In 
Place options as shown on the example below. 

 

 Click  to display all the labels in a horizontal format.  
 

 Click  to display the labels in standard format (horizontal and vertical). 
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 Click  to enable you to customise the position of labels. Individual labels can be moved by holding the left mouse button down on a label while dragging it within the CAD view. 
 

Click the Global Label Settings  button to open the Global Label Settings dialog and choose which information is displayed on the labels. You can also use this dialog to decide the width of the labels. 
 

 

Further filter display options are available by selecting the Filter Display  button. It allows you to filter out the displayed points for surface and geometric inspections. For example, to display only out-of-tolerance points in the CAD view, deselect Display all, and select Only Out-of-tolerance Points.  
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The Custom option allows you to set your own filter criteria. 
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Print Previews 
 
After you have performed a surface inspection, you can print the data. 

1 Click the ISO 2  button to position the CAD model.  

2 Click Print Preview . A preview of the CAD File, along with the probed points, is displayed on the screen. 
If you were to print the page, this would be the output. 

 

If the Print Preview  button is selected while a geometric group is open, then a graph of deviation and a coloured bar is included in the preview. 
 

  Ensure Draw the coloured scale with confetti is also selected from Tools > Options > 
Display Options. 
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  5.  Inspections 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            47                                                                                                                             

CAD view report 
PowerInspect lets you include CAD images in the final report. This feature is called CAD View Report.  
To create a CAD view report. 

1 Select the CAD View tab .  

2 Click  to select your preferred label style, and orientate the model to a suitable view. 

3 Click on the Miscellaneous  toolbar and select CAD View Report . 
Page 1 of the dialog allows you to change the Orientation, Alignment, Size and CAD View 
replay type. This enables you to choose how the CAD view behaves when a CAD view 
report item is played. 
 

 
 

Page 2 of the dialog allows you to select a template which displays information in the report image itself. 
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4 Leave the settings unchanged, and click OK to insert the CAD View Report item into the Sequence Tree. 
5 Select the Report tab to view the final results and image in the report. 
6 If you delete the CAD View Report item from the Sequence Tree, the image is also deleted 

from the report. 
Inserting a CAD View Report within an inspection sequence 
CAD View Reports can also be inserted within inspection and geometric groups.  

1 Select Inspection group 1 and open  it. The Item toolbar is replaced with the 
Inspection toolbar.  

 

2 Click  to display labels. 
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3 Click  to insert a CAD View Report item into the inspection sequence. 

 
4 View the results and image in the Report tab. The image is displayed just below the Inspection Group 1 table. 

Reports with attached images can be difficult to interpret if a high volume of points are taken, as shown. 

 
 
PowerInspect has the ability to split the report automatically and display the corresponding CAD view image only for those points on each page.  
 

5 Click  to close Inspection Group 1. 

6 Click  to modify Inspection Group 1. 
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7 At the top of the dialog, select Repeat CAD view on each page. 

  
8 Click OK. 
9 Check the results in the report. A CAD view is created at the top of each page with associated labels and table displayed. This produces a report that is easier to read and present. 
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6. Measurements without CAD 
PowerInspect does not have to work with CAD Data. Parts can be inspected for dimensional measurement and comparison without reference to a CAD model. Measurements are created using geometric elements, which are either probed, or referenced to probed elements. An alignment is required in order to have the data in the components coordinates rather than machine coordinates. 
 
Preparing a Session for Measurement Inspection 
For the purposes of this exercise, no CAD data will be used. 

Select New Document  on the Main toolbar. A new empty session is loaded. 
The new session is now ready for inspection. 
 
Generating a Measurement Inspection 
The DemoBlock2008(CMM+Arm) will be used for measurement. Align the block so that the side with the logo is facing towards the front of the CMM/Table. 

 
Initially a datum will be created at the lower rear left corner of the block. This will allow measurements to be taken relative to this point and aligned to the axes of the datum. First a geometric group will be created and a Geometric PLP alignment generated from the elements probed. 

1 Select the Delay Measure  button. 

2 From the Item Toolbar, click the Geometric Group  button. 
The Geometric Group dialog is displayed and prompts you to name the group and add a comment if 
required. 
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3 Name the group Datum Group. 
4 Deselect Output in report. 
5 Leave the other settings unchanged and click OK. 

Next, a series of geometric items need to be created for measurement from the Item toolbar. In this example, six items are created. These include three Probed Planes defining the X, Y and Z planes, two Plane Intersection Lines for the X and Y axes and a Line Intersection Point for the origin. 

6 Click the Planes  button to open the flyout. 

7 Click the Probed Plane  button. 
8 Click OK & Repeat twice, and then click OK to create three planes. 

 Plane 1 is probed from the CMM bed and defines the Z 0 plane. 
 Plane 2 is probed from the left face of the block and defines the Y 0 plane. 
 Plane 3 is probed from the front face of the block defining the X 0 plane. 

9 From the Lines  flyout, click Line: Two Planes .  
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10 Enter the name Xline.  

  

 The new line is to be generated from the intersection of the CMM table, Plane 1, and the front face of the block, Plane 2. This line is used to define the X axis in the PLP later. 
 

11 Click OK & Repeat. 
12 Enter the name Yline.  
13 Select Plane 3 to be used as Reference Plane 2. 

 
14 Click OK. 
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Now, a point is created at the intersection of Xline & Yline.  

15 From the Points  flyout, select Point from Lines Intersection . 
 

16 Enter the name Origin and ensure the dialog is completed as below. 
 

 

 This point is used as the XYZ origin in the PLP alignment. 
17 Click OK. 

18 Select Play All  to probe the three planes. 
 Plane 1 — Z0 
 Plane 2 — Y0 
 Plane 3 — X0 
The lines and point are generated automatically from the probed planes. 
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Creating the PLP alignment 
 
With the geometric items defined and measured, we can create the PLP alignment. 

1 Click  to exit Datum Group. 

2 Click Alignments  to open the Alignments flyout. 

3 Click Geometric PLP Alignment . 
4 Fill in the dialog as shown below and click OK. 

 
The CAD co-ordinate system is now aligned to the demoblock2008 part. The generated lines and point can be seen in the CAD view. This allows measurements to be made relative to the X, Y and Z axes of the block. 

 
The first dimension to be measured is the height of the block. In this case a Probed Parallel Plane item is used.  
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5 Create a new Geometric Group  and name it Measurements no CAD. 

 

 Although the measurements are output in the report, there are no CAD nominals to report against. If a drawing is available, the nominals can be set by modifying each geometrical item to be probed. 

6 From the Planes  flyout, click Probed Parallel Plane . 
7 Ensure Plane 1 is selected for the Reference Plane. 

 
8 Click OK. 

9  Click Play All  to play the item. 
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10 Probe the horizontal top face of the block. 

 

 The Feature Probing dialog shows the distance between the CMM surface and the top of the block, the flatness of the top surface, and the maximum deviation of points measured from the best fit plane. 
 The flatness and maximum deviation are not shown in the report.In the Sequence Tree, the height of the plane is updated. 

 

 We will now measure the sizes and relative positions of two holes. 
 

 

11 Click  to open the Measurements No CAD group. 
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12 In the Features  toolbar, select Probed Circle . 
13 Select Plane 4 as the Reference Plane. 

 
14 Leave the Fitting algorithm as Least square. 
15 Select OK & Repeat to create a second Probed Circle. 
16 Play both items and measure the circular holes in the block using the techniques previously learned. 

 

17 In the Dimensions  toolbar, click the Relative Position  button. 
18 Complete the dialog as below and select OK. 



  6.  Measurements without CAD 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            9                                                                                                                             

 
From the Sequence Tree, the relative positions between the two circle centres can be seen referenced to the X and Y axes of the PLP. 
 

 
Fitting Algorithms 
If required, a different fitting algorithm can be applied to the feature. Where available, fitting algorithms can be selected from the drop-down list in the feature form. 

 
The following algorithms are available: 
 Least Square — Creates a feature that best fits the probed points. The feature is calculated by minimizing the sum of squares of the deviations between the feature and each probed point. 
 Maximum Inscribed — Creates the largest feature that fits within the probed points. 
 Minimum Circumscribed — Creates the smallest feature that contains all the probed points. 
 Minimax — Creates the feature by averaging the maximum inscribed and minimum circumscribed features that have the same centre. 

By default, items are created using the Least square algorithm. 
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Measuring the length of the block in X and Y 
Finally, we will measure the overall length of the block in the X and Y directions. The distances are measured using the origin point created at the beginning of this chapter, plus two new Probed Lines. 

1 In the Lines  flyout, select Probed Line .  
2 Select Plane 1 as the Reference Plane. 
3 Click OK & Repeat, then OK to create two probed line items. 

 

4 Click  to play the lines. Measure the first line on the right of the block (parallel to plane 3) and the second on the back (parallel to plane 2). 

5 In the Dimensions  flyout, click Distance: Point - Line .  
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6 Complete the dialog as shown. 

 
7 Click OK. Line 1 is on the right face of the block, the origin is at the PLP datum origin. The distance between them gives 

the overall length of the block in X. This is shown in the updated Sequence Tree below: 

 

8 In the Dimensions  toolbar, select Distance: Point - Line . 
9 Complete the dialog as shown. 

 
10 Click OK. 

 Line 2 is on the back face of the block, the origin is at the PLP datum origin. The distance between them gives the overall width of the block in Y. This is shown in the updated Sequence Tree below: 
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Probing 3D Features 
3D features will now be added to the inspection. 

1 Click  to exit the Measurement no CAD group. 

2 Click , then OK to create a new Geometric group. 

3 From the Features toolbar , select Probed Sphere , Probed Cone  
and Probed Cylinder . Keep the default settings for all three items. 
The Sequence Tree lists the features. 

 

4 Select Play All  and probe the three features in the order defined. 

 

 The CAD view is updated to show the new probed features. 

5 In Geometric Group 1, click Circle: Cone Cylinder intersection  in the Features 
toolbar . 
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6 Select the Cone and Cylinder as reference features.  
7 Click OK.  

 Circle 3 is generated at the intersection of the cone and cylinder. 
 

  
The report shows the details of this inspection. Nominal dimensions need to be added to provide error/deviation results. These can be added at this stage by using the Modify Item button in the Sequence Tree to open each item in turn and change the nominal values. 
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There are other ways in which it is possible to measure dimensions from a part. The aim 
of this example is to give an introduction to the basics of measuring without CAD data. 
For details of alternative methods, please ask your tutor. 
Points can also be taken on the component without a CAD model. This can be useful when, for example, reverse engineering parts. Point clouds, Points on the Fly and digitised curves are methods outlined in the following chapter. The points taken will be included into the current inspection sequence. 
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7. Dimensioning 
The Dimensioning function in PowerInspect enables you to create and display measurements in the CAD view, which can then be included in the report and viewed using the Info tab. You can use it to display distances and angles between features, and the sizes of features that are included in the inspection sequence.  
In the examples used in this chapter, the dimensions are created from measured features, but you can also create dimensions from nominals.  
 
Distance dimensions 
Create distance dimensions to display distances between features on a part. You can create several types of distance dimension, for example. 
 Linear distance between two points. 
 Linear distance between a datum and a point. 
 3D distance between two points. 
 Distance between two planes. 
 Distance between two circles. 
 Perpendicular distance between a point and a line.  
Each type creates a different item in the inspection sequence. 
The following examples demonstrate how to display the linear distance between two points, and the distance between two circles. 
 
Displaying the linear distance between two points in a datum plane 
To create a linear dimension between two points. 

1 Click  to create a New Document using the Wizard. In the wizard, select Measurement with a single CAD part and click Next. 
2 Browse for Demoblock2008(CMM+Arm).dgk and click Finish to open the file. 
3 Create an alignment using one of the previously learned methods. 
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4 Create a new geometric group, and then create and play the two Probed Circle items shown below. 

 
5 Click View from Top (Z)  to ensure that the points are projected onto the XY plane. 

6 In the Mouse Context toolbar, select Dimensioning . A white dimensioning plane is displayed on the datum, showing you the plane in which the labels will be drawn. 
 

 
If you want to change the plane that is used, rotate the model in the CAD View until you are looking down the plane you want to use, and then double-click the dimensioning plane. 

7 Move the cursor over the centre of the first circle. When it is displayed in yellow, click to select it. The colour changes to red. 
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8 Move the cursor over the centre of the second circle. When it is displayed in yellow, click to select it. The colour changes to red, and a label showing the linear dimension is displayed. 

 
 

9 Use the cursor to control which measurement is displayed. 
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10 Left-click to drop the label and create a Linear Dimension item in the inspection sequence. 
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Understanding the label colours 
When you create a Dimension, the borders are coloured to indicate its status. 
 
 Gold indicates one or both of the items are unmeasured. 
 Green indicates the dimension is within tolerance. 
 Red indicates the dimension is above tolerance. 
 Blue indicates the dimension is below tolerance. 
 Black indicates the dimension has not been compared with the CAD nominals. 
 
 

 
 
You can change the colours that are used for the labels by selecting Tools > Options > Display Options > Colours and editing the Labels and Graphical Dimensions page. 
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Displaying the distance between two circles 
When you measure the distance between two circles, the measurement displayed depends on the relative positions at which the circumferences are clicked. For example, if you click the circumferences where they are closest, the inside measurement is displayed.  
To display the distance between two circles. 

1 Create a new geometric group, and then create and play the two Probed Circle items shown below. 

 
2 Click View from Top (Z) . 

3 In the Mouse Context toolbar, select Dimensioning . 
4 Press the Ctrl key, move the cursor over the first circle, and when it is displayed in yellow, click to select it. The colour changes to red. 
5 Keeping Ctrl pressed down, move the cursor over the second circle. When it is displayed in yellow, click to select it. The distance between the two circles is displayed. Release Ctrl. 
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6 Move the cursor to position the label, then left-click to drop it and create a Distance between two circles item in the inspection sequence. 

 
Editing the label 
After the label has been dropped, you can choose whether to display the outside distance, inside distance, or both. 

1 Double-click the label to open the Inside and Outside Distance between Two Circles dialog.  
2 Select both light bulbs to display the inside and outside distance in the CAD View. 

 
3 Click Apply. 

 
4 Right-click the new label, then select Move on the context menu to reposition it. 
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 Angle dimensions 
You can create angular Dimensions between features, for example:  
 Two lines in a datum plane. 
 Two lines projected on a specified plane. 
 Two planes. 
 A vector and a plane. 
When measuring 2D angle dimensions, it is important to select the correct dimensioning plane because the values displayed depend on the plane in which the measurements are taken.  
The following examples demonstrate how to display a 2D angle between two lines, and how to display a 3D angle between two planes. 
 
Displaying an angle between two lines 
To display the angle between two lines. 
 

1 Create three probed circles, then create two lines between the centres of the circles, as shown below. 

 
 

2 Play all the items. 

3 Click View from Top (Z)  to ensure that the XY plane is used for creating the dimension.  

4 In the Mouse Context toolbar, select Dimensioning . 
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5 Move the cursor over the first line. When it is displayed in yellow, click to select it. 

 
6 Move the cursor over the second line. When it is displayed in yellow, click to select it. 

 
 The angle between the two lines is displayed. 

 

 
7 Move the cursor to position the label and select which angle is shown. 
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8 When the label is positioned, left-click to drop it and create an Angle between two lines item in the inspection sequence. 

 
 

9 To display the outer angle, right-click before positioning the label to open the context menu. You can choose whether to display the inner or outer angle, and whether the angle is displayed as a positive or negative. 
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Displaying a 3D angle between two planes 
To display the 3D angle between two planes. 

1 Create a new geometric group and then create and play the two Probed Plane items shown below. 

 

2 In the Mouse Context toolbar, select Dimensioning . 
3 Move the cursor over the first plane. When it is displayed in yellow, click to select it. The plane changes to red. 
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4 Move the cursor over the second plane. When it is displayed in yellow, click to select it. The plane changes to red and the angle is displayed. 

 
5 Right-click the label to display the context menu and switch between displaying the inner or outer angle. 

 
6 Move the cursor to position the label and select which angle is shown. 
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7 Left-click to drop the label and create an Angle between two planes item in the inspection sequence. 

 
8 To reposition the Dimension after it has been placed, right-click the Dimension and select Move from the context menu. 
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Feature dimensions 
You can create dimensions for features using a similar method to creating other dimensions. Unlike other dimensions, however, you do not need to select a dimensioning plane, and these dimensions can only be created for features that are already in the inspection sequence. Feature dimensions that can be displayed include: 
 The diameter of a sphere or circle. 
 The radius of a sphere or circle. 
 The length of a slot or rectangle. 
 The width of a slot or rectangle. 
The following examples demonstrate how to display the diameter of a sphere, the radius of a circle, and the length and width of a slot. 
 
Displaying the diameter of a sphere 
To display the diameter a sphere. 

1 Create a new geometric group, and then create and play a Probed Sphere item, as shown below. 

 
 

2 In the Mouse Context toolbar, select Dimensioning . 
3 Move the cursor over the sphere. When the circumference is displayed in yellow, click to select it. 

 
 
The circumference changes to red and a label is displayed showing the diameter. 
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4 Move the cursor to position the label, then left-click to drop it. 

 
 

Displaying the radius of a circle 
To display the radius of a circle. 
 

1 Create and play a Probed Circle item. 

2 In the Mouse Context toolbar, select Dimensioning . 
3 Move the cursor over the centre of a circle. When it is displayed in yellow, click to select it. 

 
4 Move the cursor over the circumference of the circle. When it is displayed in yellow, click to select it. 
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5 Move the cursor to position the label, then left-click to drop it. 

 
6 To hide the label, right-click it and select Hide from the context menu.  
 

Displaying the length and width of a slot 
To display the length and width of a slot. 

1 Create a probed slot item, as shown below. 

 

2 In the Mouse Context toolbar, select Dimensioning . 
3 Move the cursor over the slot. When it is displayed in yellow, click to select it. The colour changes to red and a label is displayed. 

 If you created a new plane with the slot item, you need to hide the plane before you can select the slot. 
4 Use the cursor to change which measurement is displayed in the label. 
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5 Left-click to drop the label.  
After you have positioned a label, you can choose which length and radius measurements are displayed.  

6 Right-click the label and select Edit from the context menu. The Probed Slot dialog is displayed. 
7 Choose the measurements you want to display and click Apply. 
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Customising labels and leaders 
After you have positioned the dimension labels, they can be hidden from the CAD view or removed completely. Right-click a label and select Hide to remove it from the CAD view, or select Delete to remove it from the CAD view and the inspection sequence.  
You can further customise the labels by selecting the Graphical Dimensions page in the Options dialog. 

 
 
In the following example, the Arrow head size was increased and Display deviation was selected. 
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8. Inspection Exercise 
The following example creates a simple inspection sequence. The sequence includes various features shown in previous chapters, including a PLP alignment, geometric feature measurement, surface points, dynamic points, and section inspection. 
Using the methods, previously described in the course, for starting a new session. 

1 Click New Document Wizard  to open the New Inspection Session dialog. 
2 Select Measurement with a single CAD Part and click Next. 
3 Click New and browse to DemoBlock2008(CMM+Arm).dgk. 
4 Leave the Offset and Tolerance settings unchanged, and click Next.  
5 In the Variables dialog. browse for any HTML Report Template (Excel could be used, but for this example HTML is to be used). The variables in the report are displayed in the table.  
6 Click Finish. 

7 From the CAD View Toolbar, click Show shaded and wireframe  to shade the model.  

8 Click View from Top (Z)  to re-orientate the model.  

9 Click Delay Measure . 
The new session is now ready for programming. 
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8.1 Geometric PLP Alignment  
The part will be aligned using a Geometric PLP alignment. 

 

1 From the Mouse Context toolbar, select Wireframe Checker . 
2 Right-click an empty area of the CAD view and select Wireframe from the popup menu. 
3 Use the cursor to select the wireframe of a circle. 

 
The details of the circle are displayed in the Geometry Explorer tab below the Sequence Tree.  

4 In the Geometry Explorer tab, select New Probed Plane from the Linked to drop-down list. This associates the circle with a new probed plane. 

 

5 Click  to add the circle and plane items to the inspection sequence. 
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6 Use the cursor to select the wireframe of a second circle. 

 
7 Select Plane 1 from the Linked to drop-down list. 

8 Click  to add the second circle item to the inspection sequence. 

9 Click Line: Two Points  on the Lines flyout . 
10 Set Reference Point 1 to Circle 1: Centre, and Reference Point 2 to Circle 2: Centre.  

 
11 Click OK. 

The Line has now been created and the Sequence Tree has been updated to include all the geometric items. 

 

12 Click Up One Level  to close the geometric group.  
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13 Click Alignments , and select Geometric PLP Alignment . The Geometric PLP 
Alignment dialog is displayed. 

14 Use the dialog to set the reference items for the Geometric PLP alignment: 
 In the Plane area, select Plane 1. 
 In the Line area, select Line 1.  
 In the Point area, select Circle 1::Centre. 

  
15 Click OK. 



  8. Inspection Excercise 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            5                                                                                                                             

8.2 Geometric Feature Inspection 
Some 2D/3D Geometric Features will now be selected to begin the inspection sequence. 

1 Click Geometric Group  on the Item toolbar. Leave the default settings unchanged and click OK. 
In this group, the Slot and Cone will be measured. 

2 Select Wireframe Checker .  
3 The cone is a surface, so the Wireframe Checker needs to be in surface selection mode. Right-click in an empty space in the CAD view and choose Surface from the popup menu. 

 

4 Select the cone in the centre of the model, and click  to add the cone item to the inspection sequence. 

 
The slot is a Wireframe item so the Wireframe Checker needs to be returned to the Wireframe selection mode. 

5 Right-click in an empty space in the CAD view and choose Wireframe from the popup 
menu. 

6 Select the rounded slot on the side of the block. 
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7 In the Geometry Explorer tab, select New probed plane in the Linked to drop-down list.  

8 Click  to add the slot and plane items to the inspection sequence.  

9 Click  to close the geometric group.  
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8.3 Bouncing Ball 
Bouncing ball is an on-screen guide which shows you what has been measured and what is to be measured next. Points are displayed as spheres in different colours to guide the user during the inspection. The following colours are used by default. 
 
 Blue: Unmeasured point. 
  
 Red: Next point to be measured. 
  
 Grey: measured point. 
  
 Transparent Red: Actual position of point measured. 
 

  
To illustrate this functionality, the bouncing ball will be applied to the two geometric features defined above. 
 

1 Open Geometric Group 2 in the Sequence Tree to display both geometric features. 
2 Select the Features tab at the bottom of the Sequence Tree. 
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3 Bouncing ball is disabled by default. Click the Probe path generator  button to enable 
it. The button changes to .  

4 Select Cone 1 in the Sequence Tree. Its details are displayed in the Features tab. 

5 Click the Recycle  button to edit the options. 

  
6 In the Probe path strategy area, select Manual in the top drop-down list (strategy), and select Slices points in the bottom drop-down list (method). 
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 The cone displays the probe points as red spheres. Green lines/arcs show the shortest distance between the 
points. 

 

7 Select  to accept and save the geometric feature. 
8 Click Slot 1 in the Sequence Tree. Its details are displayed in the Features tab. 

9 Click the Recycle  button to edit the options. 

 
10 In the Probe path strategy area, select Manual in the top drop-down list (strategy), and select SlicesPoints in the bottom drop-down list (method). 
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11 Click Probe externally  to change it to Probe internally .  

 

12 Click  to accept and save the geometric feature. 

13 Click  to close the Slot Inspect page. 
The Bouncing Ball feature is now applied to the two geometric features. This will be activated in the Sequence 
Tree during Play mode. 

14 Click the Probe path generator button to disable the Bouncing Ball feature. The button 
changes to . 

15 Click  to close the geometric group.  
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8.4 Surface Inspection 
The next stage is to perform a surface inspection. 

1 Click the Inspection Groups icon  and then select the On the fly Surface Points 

icon . 

  
2 Set the Minimum points as 6. 
3 Click OK. 

The inspection group has been added to the inspection sequence. 
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8.5 Guided Surface Inspection 
This example creates another surface inspection but instead using guided points, the 
Dynamic Points Editor is used to specify the points to be probed.  

1 Select the Dynamic Points Editor  from the right Mouse Context toolbar. 
2 Double-click on the model surface approximately in the areas shown below, to specify the three dynamic points. 

 

3 Click Create inspection points  from the Dynamic Point toolbar. 
In the Sequence Tree, an inspection group is created including the three dynamic points.  

 

4 Click Up One Level  to close the inspection group.  

5 Click Dynamic Points Editor  to deselect it. 
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8.6 Section Group Inspection 
Finally, a Section Inspection will be included in the inspection sequence. 

1 Click View from Top (Z)  to reorientate the view down Z. 

2 From the Item toolbar click the Section Group  button. The Section dialog is 
displayed. 

3 In the Cut plane area, select X as the plane and enter 70 in the Coordinate box. 

 
4 Leave the other options unchanged, and click OK. 

The inspection sequence is now complete and the inspection sequence contains all the items you created.  

 Two extra features (inspection aids) will be added to the inspection sequence to assist the inspector.  
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8.7 CAD View State 
CAD View State items allow you to save the current CAD view (orientation and zoom) and add it to the inspection sequence.  
During the inspection, the CAD view item will load automatically, allowing the inspector to continue probing without having to pause and manipulate the CAD model manually, thus speeding up the inspection process. 

1 Zoom and orientate to a suitable view around the slot feature, then select CAD View State 

 from the Miscellaneous  toolbar.  

 
The CAD View State item is added to the bottom of the sequence. 

2 Expand Geometric Group 2 by clicking the  symbol adjacent to the name, to show the 
three geometric features. 

 
3 Select the new CAD View State item. Keep the mouse button pressed, and drag and drop 

the CAD view below Cone 1 feature. 

 The view is now placed just before the Slot feature, displaying the view just prior to the inspector probing the 
feature. 
 

 Dragging the CAD View State item would not be required if the insertion cursor  was positioned here initially.  
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8.8 Comment 
Another method of assisting the operator during inspection is to include a Comment in 
the inspection sequence. 
As with CAD View State items, Comment items should be placed into the inspection 
sequence at the point where the information needs to be seen. 

1 Select Comment  from the Miscellaneous  toolbar. The Comment dialog is displayed where instructions, including images and videos, can be added. 

 
2 Enter the following text. Probe 10 points in and around the sphere feature.  

3 Select  to save your changes. The stored comment is added to the end of the sequence. 
4 Drag and drop the new Comment item below Geometric Group 2. The comment will display 

just before the surface inspection. 
The sequence is now complete and ready for inspection. 

5 Click Play All  on the Main toolbar. 
The screen changes to Full Screen measure mode, indicating what needs to be measured and the minimum 
number of points required. 

6 Measure all the requested points. 
7 Select the Report tab to check the measurement results.  
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8.9 Play Resume 
This feature allows you to measure more probed points for the selected element. 

1 Expand Geometric group 2. 
2 Highlight and zoom into the cone feature. 

3 Select Discs  from the Geometry Feature Display toolbar. 

 Further measured points will now be added to the cone feature. PowerInspect will include these new points and 
then recalculate the cone. 
A deliberate bad point will be included in this measure to illustrate the ability of PowerInspect to choose, select, 
and discard points afterwards. This enables you to look for rogue points and to discard or replace them before 
creating the report.  

4 Select the Play with Resume  button from the Main toolbar. 
5 Probe a further 5 points, ensuring the last probed point is out-of-tolerance. 

 Every additional point taken forces PowerInspect to recalculate/refit the cone. The image above shows the refitted 
cone to include all original and the new 5 points taken.  
The out-of-tolerance point taken has forced the cone to be out-of-tolerance. This rogue point will now be excluded. 

6 Expand the cone feature  in the Sequence Tree  

 
7 Double click on Measured points 11/11.  
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 All the measured points are displayed. Point 11 is the rogue point. This point will now be excluded from the list. 
8 Highlight point 11 and select   > Delete. 

 
The point has been deleted permanently, and the cone has been recalculated without it. 
The cone is now within specification as shown below. 

 
Points do not have to be deleted to exclude them from the fitting calculation. 
You can deselect the check box next to a point to exclude its point from the calculation without losing it. This has the benefit of providing an audit trail for all measurements. 
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8.10 Custom Actions  
PowerInspect includes three buttons that enable you to run conditional tests and custom applications as part of the inspection sequence.  
You can add the custom actions to the Definition level and within a geometric group from 
the Miscellaneous  toolbar. 
Custom Stop Replay  

Use Custom Stop Continue  items to automatically stop the inspection sequence if any of the specified conditions are met. For example, a Custom Stop Continue item can be used to automatically stop the inspection if an element’s measurement is out-of-tolerance. 
When the inspection sequence is played, processing stops and a message is displayed if any specified condition is met. 
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Custom Print  

Use Custom Print  items to automatically print a report if any of the specified conditions are met. For example, a Custom Print item can be used to output results only when an item is unmeasured or out of tolerance. 

 
Custom Action  

Use Custom Action  items to automatically run an internal script or macro during the inspection sequence. For example, a Custom action item can be used to automate 
further processing or archiving of your measurement data. 
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9. Modifying Elements 
Many elements created within PowerInspect can be modified in one way or another. Modifications can be made to items, probed points and even PowerInspect itself. 
This chapter briefly goes through the deletion and reordering of points, and some display modifications. 
9.1 Accessing Modification 
You can edit or modify items in three ways. 
 Right-click an item and select Modify Item from the popup menu. 

 

 Select the item and click the Modify  button on the Sequence Tree toolbar. 

 
 Use the short-cut key combination of Alt+Enter. 

 
When you modify geometric items, the dialog that specified the item’s parameters is opened. This allows you to change the constraints that set the item. 
For example, in the Geometric PLP Alignment where a line is specified using the centres of two circles, it can be altered to pass through different elements. 
Most modifications work on similar principles, but these might affect the results. The next example shows how to delete an unwanted result, and demonstrates how to rectify the point numbers to maintain a continuous set of results. 
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9.2 Anomalous Result Example 
When probing a point, it is possible to create an unwanted or anomalous result by probing too hard, taking too many points, taking points in the wrong place, false triggering and so on. These results could affect a line of best fit or an inspection report, for example, so it is often best practice to delete them. 
In this example, the DemoBlock2008 part was probed and during the inspection an anomalous result was taken. This anomaly was verified by taking a point at the same position and comparing the results. As can be seen from the Sequence Tree, the deviation of the anomaly is much greater than that of the surrounding results, so it should be removed from the group. 
 

 The inspection group is open to display the points. 
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1 Click  to open the affected group.  
2 Right-click on the anomalous result (in this case SP7), and click Delete on the popup menu. 

The point is removed from the inspection group. 
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This leaves a gap in the point numbers, so they need to be reordered. 

 

3 Click Move Up One Level . The numbering of the surface inspection group can now 
be modified. 

4 Select Inspection Group 2 and click the Modify  button. The Surface Inspection Group 
dialog is displayed which allows you to reset the creation parameters. 
To reset the numbers for an inspection the following changes need to be made in the Item Naming Rules 
area. 

 
5 Enter a Counter value of 1. 
6 Enter an Incr. (increment) value of 1. 
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7 Select Update existing points. 

 
8 Click OK. 

The points are updated in the Sequence Tree; points SP11 and SP12 have been updated to become points 
SP10 and SP11 respectively. 

9.3 Replaying Probed Items 
Individual features and points can be replayed.  

1 Right-click SP10 and click Reset Item on the popup menu. 

  
The point is reset and the icon displayed in the Sequence Tree changes. 

 

 Selecting Reset All resets all the measures in the group. 

2 Select the point and then click Play Item . The point is shown as a dynamic point 

 in the CAD view. 
3 Probe the point. 

The Sequence Tree and report are updated with the new measure. 
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10. Exporting to CAD 
If you do not have a CAD model of a part, you can use PowerInspect to take measurements which can then be exported to CAD and used for reverse engineering with a CAD system such as PowerShape. 
10.1 Point Cloud  
Point cloud data (3D digitised data) can be obtained in two ways. 
 Contact — Using devices such as touch probes attached to portable arms or CMM machines. At point of contact, the X, Y and Z coordinates are taken. 
 Non-contact — Using devices such as line or scanning point lasers. 
To include point cloud data in an inspection sequence. 

1 Click the Point Cloud Group  button on the Item toolbar to create a point cloud group. 

  
2 Leave the settings unchanged, and click OK. The Item toolbar is replaced by the Point Cloud toolbar. 

Select an option from the toolbar which is appropriate for the action you want to perform: 
 

 Create a point cloud by probing points on the fly. Use this option to probe points on 
the part and save them as a point cloud. You can also use this option to delete previously probed points so you 
can reprobe them. If you have a CAD model, you can project the point cloud on to it to view any deviation.  
 
 

 Curve flyout. This flyout contains three options: 
 

 to probe points on the part and fit a curve through them. The curve is saved in the point cloud group and can be exported for use in CAD applications. 
 

 to create curves from sections through a CAD model. These curves can be used to create reference lines for marking out a clay model.  



               10.  Exporting to CAD         
 

                                                                                                                                      
                                                                                                             

 Autodesk PowerInspect 2017   
2                                                                                                                                                                      Copyright © Autodesk                                                                       

 to import a digitised curve from IGES or VDA files. These curves can be used to create reference lines for marking out a clay model. 
 

  Import a cloud of points from a file. Use this option to import points that have been probed 
using a different application. The cloud of points is imported as a single element in the point cloud group and can 
then be projected onto the model to find the deviation between the probed points and your CAD data. 

 

 Miscellaneous toolbar. This flyout contains two options: 
 

 to add a comment. 
 

 to add a CAD View Report to the Point Cloud group. 
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Single Points on the fly  
Single points can be taken as geometric items anywhere on the part. Single points on-the-fly are the same as guided single points, except that a nominal value does not have to be entered. 

1 Click  to create a new Geometric Group.  

2 From the Points toolbar , click Single Point on the Fly . 

  

 The Compensation drop-down list controls whether probe compensation is required on the points taken. 
 

3 Probe a number of points on the sloping surface on the block (as shown in blue). 

 

4 Click  to save the points. The points are displayed in the CAD view. 
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10.2 Digitised curves 
Digitised curves enable you to probe a curve across the surfaces of a part. Use them to measure sections around a part and to build up a picture of a part for use in reverse engineering.  
In addition to the ability to fit a curve through points probed on a part, you can also: 
 Identify edges and gaps as you probe a part. 
 Manage curve items using the Digitised Curve dialog. 
 Generate curves from CAD models. 
 Import curves generated using other software packages. 
 Rotate, translate, mirror, and scale curves. 
 View and edit point measurements. 

 
Creating a digitised curve 
To create digitised curves. 

1 Ensure the part is secured to the CMM bed. 

2 Click  to create a new Geometric Group. Alternatively, you can create a Point Cloud group. 

3 Click  to display the Curve flyout, then click the Curve  button. The Sketch Curve Tool dialog is displayed.  

 

 The dialog contains the following buttons: 

 Reset All  to reset all points taken for the currently active item. 

 Reset  to reset the last probed point.  

 New Curve  to save the probed points to a new Digitised Curve item and start a new curve. 

 OK  to save the probed points to a new Digitised Curve item and close the dialog. 
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 Cancel  to discard any unsaved points and closed the dialog. 

 Edge point  to identify a discontinuity, such as an edge or a corner in the surface. 

 Gap point  to insert a gap before the next probed point. 

 Close/Open Curve /  to connect the first and last point and close the curve. Click again to open the curve. 

 Curve Sketching Options  to display the Curve Sketching Options dialog. Use this dialog to change the curve fitting tolerance or use a guided plane to control probing. 

 Toggle Guided Plane  to toggle the guided plane. 
 

4 Probe the points on the part to create a curve. You can probe as many or as few points as you want. 
5 Gaps and edges in the curve can be marked using the buttons on the Sketch Tool dialog, extending your ability to describe the surface of a part while it is being probed. 

 

  
Probed points are colour coded depending on their function: 
 Green indicates the start point of the curve. 
 Red indicates the end point of the curve. 
 Blue indicates a gap point. 
 Yellow indicates an edge point. 
 purple indicates other points in the curve. 

 
 You can change the point colours using the Curve page of the Options dialog. 

 

6 When you have finished probing the curve, click  to save the points to a new Digitised Curve item in the Sequence Tree. 
Alternatively, click  to save the points and start a new curve.  
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10.3 Geometric multi-measure  
Geometric Multi-Measure allows you to measure multiple geometric features without having to create items first. The Multi-Measure feature is available from the Geometric toolbar. 

1 From the Item toolbar, click the Geometric Group  button. 
2 In the Geometric Group dialog, leave the settings unchanged and click OK. 

3 Select Geometric Multi-Measure  from the Geometric toolbar. 

 
4 By default, the dialog is ready to probe plane features. To probe another type of feature, 

select the Item selection  button, then select the required feature from the selection list. 
 

 

5 When you have probed all the required features, select  to close the Multi-Measure dialog. 
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10.4 File Export 
When you have measured geometric items or surfaces, you can use the data as a basis for reverse engineering by exporting it in a format that can be used in modelling applications. You can export to IGES, VDA-FS 2.0, ddz, ddx and dgk formats.  

1 From the File menu, select Export > Export as CAD. The Export as CAD dialog is displayed. 

  
2 Click Browse. The Save As dialog is displayed. 
3 In the Save As dialog, enter a name and choose a file type, then click Save.  
4 In the Options area, select the check boxes of the attributes that you want to export. 

By default, a unique identification and colour number is assigned to each attribute for use in differentiating the 
different types of information associated with exported items. If you do not want to differentiate between the 
selected attributes, enter the same number in all the Level and Colour boxes. 

5 Select the Export surface as NURBS check box to export the data in NURBS format; deselect the check box to export 3D items in Surface of Revolution format, and 2D items as points or Ruled Surfaces. 
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6 Select the Export curves as polylines check box to export curves as a series of straight lines connecting the measured points; deselect the check box to export curves in NURBS format. 
7 In the Coordinate system area, select CAD to export the measurements in CAD coordinates, or select CMM to export the measurements in machine coordinates. 
8 In the Selection area of the dialog, select the check boxes of the groups whose contents you want to export 
9 Click OK to close the dialog and save the selected data to file. 

The data can be now be imported into a CAD system and manipulated as required. 
 
The picture below shows the data imported into PowerShape, where the probed planes and features are now represented as NURB surfaces. 
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11. Device Repositioning 
The repositioning wizard in PowerINSPECT provides the ability to move the part and/or measuring device without losing the alignment. This allows you to inspect a part that is larger than the device’s measuring envelope. 
The wizard works by creating a new repositioning datum by specifying at least three elements. These elements can be a combination of spheres and single points. The part or device can then be relocated and the same elements measured again. PowerINSPECT matches the two positions and so can relate the new measurements to the original alignment.  
This allows you to carry on inspecting the part using the same co-ordinate system. 
After creating a position, it can be edited and deleted from the session. The position can also be reactivated if you are certain that inspection device is in the exact same position. 
If needed the part can be moved instead of the device providing the reposition points can be probed.  

1 Click New Document Wizard  to open the New Inspection Session dialog. 
2 Select Measurement with a single CAD Part and click Next. 
3 Click New and browse to DemoBlock2008(CMM+Arm).dgk. 
4 Leave the Offset and Tolerance settings unchanged, and click Finish. 
5 Create and play an alignment using one of the previously described methods. 

 

6 From the Machine toolbar , click Repositioning Wizard . 
7 Select the first option, then click Next. 
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 The elements are selected at this stage (at least three). 

 

 Click  to create a sphere element. 

 Click  to create a single point element  
 
 

 Only a hard probe should be used. 
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For this example, three single point elements are selected on the DemoBlock2008 part, as shown: 

 

8 Click  three times to select three single point elements.  

 
9 Click Next. The three elements now require measurement 
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10 Measure the three point items. 

  
The measured coordinates for the three points are displayed. 
 

11 Click Next. 
The wizard instructs you to move the inspection device to a new location. 

 
12 Move the inspection device (or to simulate the same effect, move the component block to a new location). 
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13 Click Next. 
14 Measure the same three points in the same order as initially taken and click Next. 

 
The deviation from the transformation is shown. Calculate Deviation can be used to calculate the deviation 
from selected items. 

15 Click Finish to complete the Device Reposition Wizard. 
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The new position is saved. Name it Position 2.  

 
16 Previously saved positions can be reactivated or edited from the opening page of the Wizard. 
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12. Machine Tab (Manual CMM) 
The Machine tab is used to manage the measuring device when PowerInspect is connected to a CMM. 

 No information is displayed in the Machine tab if PowerInspect is connected to an arm. 
 
The Machine tab is available from the document window to enable you to manage the 
probe heads, probes and calibrations in one place. 
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12.1 The Probe view 
The probe view lists the details of the measuring device and probing tools for the document. 

 
The active probe head, probe, and probe position are shown in bold. The view also 
indicates the calibration status by displaying a calibrated tick  or uncalibrated cross  for each entry in the list. The following options are available: 

 Change active probe or probe position. 
 

 Edit the selected probe tool assembly. 
 

 Define a new probe position. 
 

 Delete the selected item in the tree. 
 

 Delete all uncalibrated probe positions in the tree. 
 

 Delete all probe positions in the tree. 
 

 Calibrate the selected item. 
 

 Calibrate all uncalibrated probe positions in the document. 
 

 Calibrate all probe positions in the document. 
The following exercises demonstrate the creation of a new probe assembly and calibration. 

 The exact procedure will vary from CMM to CMM. You should follow the prompts given on your machine. Ask your tutor if in doubt. 
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12.2 Creating a new probe assembly 
For the purposes of this exercise, no CAD data will be used. 

1 Click New Document . A new empty session is loaded. 

2 Click Toggle Machine toolbar  on the Main toolbar. 
 

3 Click the Connection  button to connect PowerInspect to the CMM. 
If successful,  is displayed in the Machine toolbar. 

4 If prompted, move the probe head to the specified angles and click OK. 

 
The Machine toolbar displays the Not Homed message. 

 

5 Click Home . 
6 Move the CMM to the positive end stops (machines vary) and then trigger the probe as requested. 

The following assembly will be created as an example. Where applicable, substitute the components to match your own hardware. 
1 Expand the Probe Head tab by selecting the down arrow . 
2 From the drop-down list, select the head MH20i. 

 

 You can also create a new, custom probe head from this tab. 
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Select Create to display the Create custom probe head dialog and enter your custom values. 

 
The head type can be changed here (for example, Fixed, Manual Indexable). 

3 Expand the Probe Tool  tab. 

 

 The Probe tool tab provides the ability to create, edit and delete probes. Clone allows you to quickly copy an existing probe assembly and change/modify the required details to create a new one  
4 Click New.  
5 At the top of the tab, enter a name for this assembly (e.g. New Assembly). 

At the bottom the tab, a list of modules is displayed. 
6 Select the TP20_STD module. 
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7 Click Insert Part. 

 
8 Select the M2_20x2_SS stylus. 

 
9 Click Insert Part. 

 
10 The final component to be selected is an extension. No extension is required for this example, so click Save. A message is displayed prompting you ensure the fitted probe matches the new assembly. 

 
11 Ensure the correct assembly is fitted, and then click OK. 

The defined probe and probe tool are kept in the .pwi file when saved, therefore this procedure does not need to be repeated for each new .pwi session. 
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There are three options at the bottom of the Machine Tab. 

 
These settings can be imported or exported (saved) to be used in other .pwi files. Therefore, this procedure does not need to be repeated for each new .pwi session. 
You can also choose to export these settings to a definition .pdb file, which can then be imported into other .pwi files. In this way, you do not need to set up the same settings for each .pwi file. 
To specify the default settings, click Export As Default on the Machine tab. This saves your settings to a default.pdb file, which is automatically loaded each time you create a new inspection session. 
The new assembly is now displayed at the top of the Machine tab, summarising the tool setup. 
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12.3 Calibration 
After you have created a new assembly, it will need to be calibrated. 

1 Click  to expand the Calibration tab. 

 The current diameter of the calibration sphere is displayed here. This can be changed after the head is calibrated. 
2 Click Calibration Settings to display the Calibration settings dialog. This dialog can be used 

to change the overall settings for the calibration. 

 
3 Leave the settings as default and click OK. 

The Head must be calibrated first. 
4 Click Head-MH20i in the assembly tree to highlight it . 
5 Click Calibrate selected item . The Probe Head calibration Wizard is displayed.  

 
6 Click Next. 
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7 Enter the size of the calibration sphere, and the vector direction of its normal (if asked). 

 
8 Click Next.  
9 The next stage involves the creation of the Probe tool fitted to the head. Select the New 

Assembly (or if required, enter a new name and diameter). 

 
10 Click Next. 
11 You are prompted to enter the direction of the probe when it is at the A=0, B=0 position. In this case it is directly down Z. 
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12 Click Next. 

 You have the option to select angles you wish to use in the calibration process. This is useful if the default (first 
option) angles are difficult to apply. 

13 Leave the first default option selected. 
14 Click Next. 

The wizard prompts you to probe the calibration sphere. 
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15 Click Next to start the process. 

 
16 If prompted, change the head angles to A=0, B=0. 

  
17 Click OK. The Manual calibration dialog is displayed. 
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18 Take at least 4 points around the sphere as shown. 

 
19 Click OK. 
20 Change the probe head angles to A=90, B=0. 

 
21 Click OK. The Manual calibration dialog is displayed. 
22 Take at least 4 points. 

  
23 Click OK. 
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24 Change the probe head angles to A=90, B=90. 

  
25 Click OK. 
26 Take at least 4 points. 

 
27 Click Finish to complete the calibration process. 

The assembly tree is updated to reflect the calibration. The head and three positions used are calibrated and 
identified with a green tick. 

 
The list is currently displayed in the order the probe positions were created. Right-click on New Assembly 
or a probe position allows the positions to be sorted in a number of ways. 

  
Currently, the position A: 90 B: 90 is highlighted in bold. This identifies it as the active position.  
If a different position is required, you must activate it first. 
 

28 Click A: 0.0 B: 0.0 to highlight it . 
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29 Click Activate selected item .  
30 Move the probe head to the position requested. 

  
31 Click OK. 

Position A=0, B=0 is now ready to use. 
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12.4 Adding further probe positions 
Further probe positions can be added using the Positions dialog. 

1 Select the New Assembly in the tree. 
 

2 Click Add new position . 

 Use the slider bars or enter values directly in the boxes. 
3 Enter A=45, B=45. 

 
4 Click Add to add it to the current list of positions. 

 
5 Select OK to close the dialog. 

The new position is now listed in the assembly tree but it is marked by a red cross identifying it as uncalibrated. 
6 Highlight the position   
7 Click Calibrate selected item . 

 
8 When prompted, change the position of the probe to A=45, B=45. 
9 Click OK. The Manual calibration dialog is displayed. 
10 As with the previous calibration, take at least 4 points, and then click OK. 
11 Click Finish to close the Calibration Wizard. 

The new position is calibrated, active, and ready for use . 
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12.5 Single Point Calibration 
Single point calibration is a method of determining the position of the probe tip. Instead of probing multiple positions on a calibration sphere, single point calibration uses the nominal offsets of the probe head and probe diameter, and one calibration point to calculate the offset of the probe tool. This enables you to quickly change the probe assembly and adjust the probe orientation without the need to go through a lengthy calibration procedure before running the inspection sequence. 
Enabling single point calibration 
To enable single point calibration: 

1 Select the Tools > Options menu option. The Options dialog is displayed.  
2 Select the Calibration page.  
3 Select the Simple option.  

 
4 Click OK to save your changes and close the dialog. 
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Calibrating the probe head 
With the simple calibration method, PowerInspect uses the probe head nominal to calculate the position of the probe tip, so there is no need to perform any calibration measurements on it. However, before you can use the nominal to calibrate the probe head, you must specify the mounting direction of the probe head to specify the vector in which the offset is to be applied. 
 
To calibrate the probe head: 

1 Select the Machine tab.  
2 In the Probe view, select the probe head and click . Alternatively, in the Probe head area, select the probe head you want to use, and then click Calibrate.  

The Probe Head Mounting Direction dialog is displayed. 

 
3 Select an entry in the drop-down list to specify which machine axis the head is parallel to. If you select Custom, enter the orientation vector for the probe head in the I, J, and 

K boxes. 
4 In this case, leave the settings as default. Click OK to close the dialog and calibrate the 

probe head. 
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Calibrating the probe tool 
After calibrating the probe head, you can calibrate the probe tool. But first, you need to specify a calibration position. 

1 Select the probe tool in the list of available tools and click the Calibrate  button. The 
Calibration and Positions dialog is displayed.  

 
2 Use the Alignment list to select the alignment in which you want to report the calibration positions. In this example, there is no alignment available, so select No Alignment to display and specify positions in machine coordinates.  
3 In the Mode area, select the Acquire positions option.  

 
4 In the Probe compensation list, you can specify the direction in which you want to apply compensation for the diameter of the probe. Select:  

 an axis to always apply compensation along the vector of that axis.  
 Automatic compensation to apply compensation along the main axis nearest to the probing direction.  
 No compensation to use the position of the probe centre without compensation. 
 For this example, select No Compensation. 

5 Enter a Name for the calibration position.  
6 Specify the location of the calibration position:  



               12.   Machine Tab         
 

                                                                                                                                                                                                                                                   
 Autodesk PowerInspect 2017   

18                                                                                                                                                                      Copyright © Autodesk                                                                                                                     

 To create a position by probing a location in the workspace of the measuring device, click the Measure point button and probe the point.  
 To create a position at a specified location, deselect the X-Axis, Y-Axis, and Z-Axis check boxes, enter the coordinates in the adjacent boxes, and click the Acquire position button.  
 To create a position at the current location of the probe tip, click the Acquire position button.  
 When you have created a position, its name and coordinates, and the time at which it was taken are displayed in the position list. 

7 Repeat steps 4 to 6 to create more calibration positions.  
 To change a point, select its entry in the list, click Edit, and enter new coordinates for the axes. 

8 When you have created the positions you want to use, you can now calibrate the probe tool. Leave the Calibration and Positions dialog open. 
Calibrating the probe tool 

1 In the Calibration and Positions dialog, select the Calibrate option.  

 
2 Orientate the probe.  
3 In the position list, select the location with which you want to calibrate the probe. 

 
4 Move the probe tip to the selected position, and click the Acquire position button. Alternatively, click the Measure point button and probe the position. 
5 Click Close. 
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13. Help & Shortcuts 
This chapter contains information about the Help menu and useful keyboard shortcuts. 
13.1 Help menu 

 
Use the Help menu to access information about PowerInspect. Select: 
 Contents to display the reference help file. 
 What's new to display the What's New file. The What's New includes information on new and updated features for the current release of PowerInspect. 
 What's this? to display help on a specific feature. The cursor changes to . Click on a button, toolbar or area to display the relevant page in the Reference Help. 
 Check for PowerInspect updates to check if there are any updates available with your software licence. 
 Check for PAF updates to check if there are any updates required for your PAF. 
 Subscribe to the PowerInspect Newsletter to sign up and receive the latest information about PowerInspect by email.  
 Visit the user forum to display the user forum page. You can use the forums to discuss any issues with other customers. 
 On the web to visit the PowerInspect homepage. 
 Product and system details to display a .txt file containing system information, details about your PowerInspect install and licensing information. 
 About to display a dialog showing information about the application. 
 
13.2 Keyboard shortcuts 
There are keyboard shortcuts for many of the common operations within PowerInspect. 
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Opening, closing and printing files 
File > New Ctrl+n 
File > Open Ctrl+o 
File > Save Ctrl+s 
File > Print Ctrl+p 

Editing files 
Edit > Cut Ctrl+x or Shift+Delete 
Edit > Copy Ctrl+c 
Edit > Paste Ctrl+v 
Edit > Delete Delete 

Manipulating the view 
View > Resize to Fit Ctrl+a 
View > Show Grid Ctrl+g 
View > From > Top (Z) Ctrl+5 
View > From > Front (-Y) Ctrl+2 
View > From > Right (X) Ctrl+6 
View > From > Bottom (-Z) Ctrl+0 
View > From > Back (Y) Ctrl+8 
View > From > Left (-X) Ctrl+4 
View > ISO > Isometric 1 Ctrl+1 
View > ISO > Isometric 2 Ctrl+3 
View > ISO > Isometric 3 Ctrl+9 
View > ISO > Isometric 4 Ctrl+7 
Toggle shading s 
Toggle hidden lines w 
Wireframe view F2 
Shaded view F3 
Wireframe with hidden lines view F4 
Zoom in d 
Zoom out h 

 
Working with surface inspection groups 

Sort points by name Shift+Ctrl+Alt+1 
Sort points by deviation Shift+Ctrl+Alt+2 



  13.   Help & Shortcuts 
                           

 

      
Autodesk PowerInspect 2017    
Copyright © Autodesk            3                                                                                                                             

Working with dynamic points 
Reverse the direction of the normal projecting from the dynamic point Ctrl+m 
Convert a surface point to an edge point or convert an edge point to a surface point 

Ctrl+b 

Working with point clouds 
Project points in the Point Cloud tab onto the CAD surface Ctrl+Alt+p 
Load point clouds from a file to evaluate a selected laser-scanned item 

Ctrl+Alt+f 

Working in full-screen measurement mode 
Accept the points taken and close the current Feature Probing dialog Enter 
Cancel all the points taken and close the current Feature Probing dialog 

Esc 

Delete the last point taken Backspace 
Delete all points taken Ctrl+Backspace 
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